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This preface describes who should read the Cisco Service Control Application Reporter User 
Guide, how it is organized, and its document conventions. 
 

Document Revision History 
 
Cisco Service Control Release Part Number Publication Date 

Release 3.0 OL-8411-01 December, 2005 

 
 

Audience 
This guide is for experienced network administrators who are responsible for generating reports 
of the daily operation using the Cisco Service Control Application Reporter, (SCA Reporter). 
 

Organization 
This guide is organized as follows: 
Chapter Title Description 

Chapter 1 Overview (on page 1-1) Provides a brief overview of the Cisco Service Control 
solution and describes the components of the system. 

Chapter 2 System Overview (on page 2-1) Provides an introduction to the Cisco Service Control 
Application Reporter, explains some basic concepts, provides 
instructions on how to install and launch the SCA Reporter. 
It also provides Basic terminology and a Quick Start section. 

Chapter 3 Using the SCA Reporter (on page 
3-1) 

Describes basic and advanced configuration of the SCA 
Reporter. It also describes how to navigate within the GUI. 

Chapter 4 Defining the Report (on page 4-1) Describes the features of the SCA Reporter, including 
creating a new report, generating a report, modifying an 
existing report, and deleting a report. 

Chapter 5 Working with Reports (on page 4-
1) 

Describes the available actions for the SCA Reporter, 
including viewing and adjusting chart display.  

Preface 
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Chapter Title Description 

Chapter 6 Command-Line Interface (on page 
6-1) 

Explains how the Reporter Command-Line Interface is used 
to generate reports. 

Appendix A Installing and Upgrading SCA 
Reporter Templates (on page A-1) 

Describes how to install and upgrade SCA Reporter 
templates. 

Appendix B SCA Reporter as a Tool in SCA BB 
Console (on page B-1) 

Describes the SCA Reporter as a tool in SCA BB Console. 

Appendix C SCA Reporter Templates (on page 
C-1) 

Describes the report parameters of the SCA Reporter 
templates, organized by template groups. 

 

 
 

Related Documentation 
The following publications are available for the Cisco Service Control Application Reporter: 

• Cisco Service Control Application for Broadband User Guide 

• Cisco Service Control Application for Broadband Reference Guide 

• Cisco Service Control Application for Broadband Developer Guide 

The following publications may also be useful, if available:  

• Cisco SCE 2000 4xGBE Installation and Configuration Guide 

• Cisco SCE 2000 4/8XFE Installation and Configuration Guide 

• Cisco SCE 1000 2XGBE Installation and Configuration Guide 
 

Conventions 
This document uses the following conventions: 
Convention Description 

boldface font Commands and keywords are in boldface. 

italic font Arguments for which you supply values are in italics. 

[ ] Elements in square brackets are optional. 

{x | y | z} Alternative keywords are grouped in braces and separated by 
vertical bars. 

[x | y | z] Optional alternative keywords are grouped in brackets and separated 
by vertical bars. 

string A nonquoted set of characters. Do not use quotation marks around 
the string, or the string will include the quotation marks. 

screen font Terminal sessions and information the system displays are in 
screen font. 

boldface screen font Information you must enter is in boldface screen font. 
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Convention Description 

italic screen font Arguments for which you supply values are in italic screen 
font. 

→ This pointer highlights an important line of text in an example. 

^ The symbol ^ represents the key labeled Control—for example, the 
key combination ^D in a screen display means hold down the 
Control key while you press the D key. 

< > Non printing characters, such as passwords, are in angle brackets. 

[ ] Default responses to system prompts are in square brackets. 

!, # An exclamation point (!) or a pound sign (#) at the beginning of a 
line of code indicates a comment line. 

Notes use the following conventions: 
 

 
 

Note Means reader take note. Notes contain helpful suggestions or references to materials not contained in 
this manual. 

Cautions use the following conventions: 
 

 
 

Caution Means reader be careful. You are capable of doing something that might result in equipment damage or 
loss of data. 

Warnings use the following conventions: 
  

 
 

Warning Means reader be warned. You are capable of doing something that might result in bodily injury. 
 

Obtaining Documentation 
The following sections provide sources for obtaining documentation from Cisco Systems. 
 

World Wide Web 
You can access the most current Cisco documentation on the World Wide Web at the following 
sites: 

• http://www.cisco.com 

• http://www-china.cisco.com 

• http://www-europe.cisco.com 
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Documentation CD-ROM 
Cisco documentation and additional literature are available in a CD-ROM package, which ships 
with your product. The Documentation CD-ROM is updated monthly and may be more current 
than printed documentation. The CD-ROM package is available as a single unit or as an annual 
subscription. 
 

Ordering Documentation 
Cisco documentation is available in the following ways: 

• Registered Cisco Direct Customers can order Cisco Product documentation from the 
networking Products MarketPlace: 

http://www.cisco.com/cgi-bin/order/order_root.pl 

• Registered Cisco.com users can order the Documentation CD-ROM through the online 
Subscription Store: 

http://www.cisco.com/pcgi-bin/marketplace/welcome.pl 

• Nonregistered Cisco.com users can order documentation through a local account 
representative by calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, 
in North America, by calling 800 553-NETS(6387). 

 

Documentation Feedback 
If you are reading Cisco product documentation on the World Wide Web, you can submit 
technical comments electronically. Click Feedback in the toolbar and select Documentation. 
After you complete the form, click Submit to send it to Cisco. 

You can email your comments to bug-doc@cisco.com. 

To submit your comments by mail, use the response card behind the front cover of your 
document, or write to the following address: 

Attn Document Resource Connection 

Cisco Systems, Inc. 

170 West Tasman Drive 

San Jose, CA 95134-9883 

We appreciate your comments. 
 

Obtaining Technical Assistance 
Cisco provides Cisco.com (on page xi) as a starting point for all technical assistance. Customers 
and partners can obtain documentation, troubleshooting tips, and sample configurations from 
online tools. For Cisco.com registered users, additional troubleshooting tools are available from 
the TAC website. 
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Cisco.com 
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, 
open access to Cisco information and resources at anytime, from anywhere in the world. This 
highly integrated Internet application is a powerful, easy-to-use tool for doing business with 
Cisco. 

Cisco.com provides a broad range of features and services to help customers and partners 
streamline business processes and improve productivity. Through Cisco.com, you can find 
information about Cisco and our networking solutions, services, and programs. In addition, you 
can resolve technical issues with online technical support, download and test software packages, 
and order Cisco learning materials and merchandise. Valuable online skill assessment, training, 
and certification programs are also available. 

Customers and partners can self-register on Cisco.com to obtain additional personalized 
information and services. Registered users can order products, check on the status of an order, 
access technical support, and view benefits specific to their relationships with Cisco. 

To access Cisco.com, go to the following website: 

http://www.cisco.com 
 

Technical Assistance Center 
The Cisco TAC website is available to all customers who need technical assistance with a Cisco 
product or technology that is under warranty or covered by a maintenance contract. 
 

Contacting TAC by Using the Cisco TAC Website 
If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the 
TAC website: 

http://www.cisco.com/tac 

P3 and P4 level problems are defined as follows: 

• P3—Your network is degraded. Network functionality is noticeably impaired, but most 
business operations continue. 

• P4—You need information or assistance on Cisco product capabilities, product installation, or 
basic product configuration. 

In each of the above cases, use the Cisco TAC website to quickly find answers to your questions. 

To register for Cisco.com (on page xi), go to the following website: 

http://tools.cisco.com/RPF/register/register.do 

If you cannot resolve your technical issue by using the TAC online resources, Cisco.com 
registered users can open a case online by using the TAC Case Open tool at the following website: 

http://www.cisco.com/tac/caseopen 
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Contacting TAC by Telephone 
If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC by telephone and 
immediately open a case. To obtain a directory of toll-free numbers for your country, go to the 
following website: 

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml 

P1 and P2 level problems are defined as follows: 

• P1—Your production network is down, causing a critical impact to business operations if 
service is not restored quickly. No workaround is available. 

• P2—Your production network is severely degraded, affecting significant aspects of your 
business operations. No workaround is available. 
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This chapter provides a general overview of the Cisco Service Control solution. It introduces the 
Cisco Service Control concept and the Service Control capabilities. It also briefly describes the 
hardware capabilities of the Service Control Engine (SCE) platform, as well as the Cisco specific 
applications that together compose the total Cisco Service Control solution. 

This chapter contains the following sections: 

• The Cisco Service Control Concept 1-1 

• Service Control Capabilities 1-2 

• The SCE Platform 1-3 

• Management and Collection 1-4 
 
 

The Cisco Service Control Concept 
The Cisco Service Control solution is delivered through a combination of purpose-built hardware 
and specific software solutions that address various Service Control challenges faced by service 
providers. The SCE platform is designed to support classification, analysis, and control of 
Internet/IP traffic. 

Service Control enables service providers to create profitable new revenue streams while 
capitalizing on their existing infrastructure. With the power of Service Control, service providers 
have the ability to analyze, charge for, and control IP network traffic at multi-Gigabit wire line 
speeds. The Service Control solution also gives service providers the tools they need to identify 
and target high-margin content-based services, and enable their delivery. 

As the downturn in the telecommunications industry has shown, IP service providers' business 
models need to be reworked to make them profitable. Having spent billions of dollars to build 
ever larger data links, providers have incurred massive debts and rising costs. At the same time, 
access and bandwidth have become a commodity where prices continually fall and profits 
disappear. Service providers have realized that they must offer value-added services to derive 
more revenue from the traffic and services running on their networks. However, capturing real 
profits from IP services requires more than simply running those services over data links; it 
requires detailed monitoring and precise, real-time control and awareness of services as they are 
delivered. Cisco provides Service Control solutions that allow the service provider to bridge this 
gap. 
 

C H A P T E R  1  

Overview 
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Cisco Service Control Application for Broadband - Service Control for Broadband Service Providers 
Service providers of any access technology (DSL, cable, mobile, and so on) targeting residential 
and business consumers must find new ways to get maximum leverage from their existing 
infrastructure, while differentiating their offerings with enhanced IP services. 

The Cisco Service Control Application for Broadband (SCA BB) adds a new layer of service 
intelligence and control to existing networks that can: 

• Report and analyze network traffic at subscriber and aggregate level for capacity planning 

• Provide customer-intuitive tiered application services and guarantee application SLAs 

• Implement different service levels for different types of customers, content, or applications 

• Identify network abusers who are violating the Acceptable Use Policy 

• Identify and manage peer-to-peer, NNTP (news) traffic, and spam abusers 

• Enforce the Acceptable Use Policy (AUP) 

• Integrate Service Control solutions easily with existing network elements and BSS/ OSS 
systems 

 

Service Control Capabilities 
At the core of the Cisco Service Control solution stands the purpose-built network hardware 
device: the Service Control Engine (SCE). The core capabilities of the SCE, which support a wide 
range of applications for delivering Service Control solutions, include: 

• Subscriber and application awareness—Application-level drilling into IP traffic for real-time 
understanding and controlling of usage and content at the granularity of a specific subscriber. 

• Subscriber awareness—The ability to map between IP flows and a specific subscriber for 
maintaining the state of each subscriber transmitting traffic through the SCE platform, and 
enforcing the appropriate policy on this subscriber's traffic 

Subscriber awareness is achieved using dedicated integrations with subscriber 
management repositories, such as a DHCP or a Radius server, or via sniffing of Radius or 
DHCP traffic 

• Application awareness—The ability to understand and analyze traffic up to the application 
protocol layer (Layer 7) 

For application protocols implemented using bundled flows (such as FTP, which is 
implemented using Control and Data flows), the SCE platform understands the bundling 
connection between the flows and treats them accordingly 

• Application-layer, stateful, real-time traffic control—The ability to perform advanced control 
functions, including granular BW metering and shaping, quota management, and redirection, 
using application-layer stateful real-time traffic transaction processing. This requires highly 
adaptive protocol and application-level intelligence. 

• Programmability—The ability to quickly add new protocols and easily adapt to new services 
and applications in the ever-changing service provider environment. Programmability is 
achieved using the Cisco Service Modeling Language (SML). 
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Programmability is required for new services to be deployed quickly, and it provides an easy 
upgrade path for network, application, or service growth. 

• Robust and flexible back-office integration—The ability to integrate with existing third-party 
systems at the Service Provider, including provisioning systems, subscriber repositories, 
billing systems, and OSS systems. The SCE provides a set of open and well-documented APIs 
that allows a quick and robust integration process. 

• Scalable high-performance service engines—The ability to perform all these operations at 
wire speed. 

 

The SCE Platform 
The SCE family of programmable network devices is capable of performing application-layer 
stateful-flow inspection of IP traffic, and controlling that traffic based on configurable rules. The 
SCE is a purpose-built network device that uses ASIC components and RISC processors to go 
beyond packet counting and delve deeper into the contents of network traffic. Providing 
programmable, stateful inspection of bidirectional traffic flows and mapping these flows with user 
ownership, the SCE platforms provide a real-time classification of network usage. This 
information provides the basis of the SCE advanced traffic-control and bandwidth-shaping 
functionality. Where most bandwidth shaper functionality ends, the SCE provides more control 
and shaping options including: 

• Layer 7 stateful wire-speed packet inspection and classification  

• Robust support for over 600 protocols and applications including: 

• General—HTTP, HTTPS, FTP, TELNET, NNTP, SMTP, POP3, IMAP, WAP, and others 

• P2P file sharing—FastTrack-KazaA, Gnutella, BitTorrent, Winny, Hotline, eDonkey, 
DirectConnect, Piolet, and others 

• P2P VoIP —Skype, Skinny, DingoTel, and others 

• Streaming & Multimedia—RTSP, SIP, HTTP streaming, RTP/RTCP, and others 

• Programmable system core for flexible reporting and bandwidth control  

• Transparent network and BSS/OSS integration into existing networks  

• Subscriber awareness that relates traffic and usage to specific customers 
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The following diagram illustrates a common deployment of an SCE platform in a network. 

Figure 1-1: SCE Platform in the Network 

 
 

Management and Collection 
The Cisco Service Control solution includes a complete management infrastructure that provides 
the following management components to manage all aspects of the solution: 

• Network management 

• Subscriber management 

• Service Control management 

These management interfaces are designed to comply with common management standards and to 
easily integrate with existing OSS infrastructure. 

Figure 1-2: Service Control Management Infrastructure 
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Network Management 
Cisco provides complete network FCAPS (Fault, Configuration, Accounting, Performance, 
Security) Management. 

Two interfaces are provided for network management: 

• Command Line Interface(CLI)—The CLI is accessible through the Console port or through a 
Telnet connection; it is used for configuration and security functions 

• SNMP—SNMP provides fault management via SNMP traps, as well as performance 
monitoring functionality 

 

Subscriber Management 
In cases where SCA BB is used to enforce different policies on different subscribers, and tracks 
usage on an individual subscriber basis, the Service Control Subscriber Manager (SM) component 
may be used as middleware software for bridging between the OSS and the SCE platforms. 
Subscriber information is stored in the SM database and can then be distributed between multiple 
platforms according to actual subscriber placement. 

The SM provides subscriber awareness, mapping network IDs to subscriber IDs. It obtains 
subscriber information using dedicated integration modules, which integrate with AAA devices, 
such as Radius or DHCP servers. 

Subscriber information may be obtained in one of two ways: 

• Push Mode—The SM pushes subscriber information to the SCE platform automatically upon 
logon of a subscriber 

• Pull Mode—On-demand, in response to a query from the SCE platform to the SM 
 

Service Configuration Management 
Service configuration management is the ability to configure the general service definitions of a 
Service Control application. A service configuration file containing settings for traffic 
classification, accounting & reporting, and control is created and applied to an SCE platform. 
SCA BB provides tools to automate the distribution of these configuration files to SCE platforms, 
and this simple, standards-based approach makes it easy to manage multiple devices in a large 
network. 

Service Control provides an easy-to-use GUI to edit and create these files, as well as a complete 
set of APIs to automate their creation. 
 

Collection 
The Service Control solution generates usage data and statistics from the SCE platform and 
forwards them as Raw Data Records (RDRs), using a simple TCP-based protocol (RDR-
Protocol). The Service Control solution provides the Service Control Collection Manager (CM) 
software as an implementation of a collection system, listening in on RDRs from one or more 
SCE platforms, and processing them on the local machine. The data is then stored for analysis and 
reporting functions, as well as simple collection and presentation of data to additional OSS 
systems such as billing. 
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The SCA Reporter is the Cisco Service Control Application tool that allows you to produce 
reports based on the traffic analysis performed by the Service Control Engine (SCE) platform. 
The information is sent from the SCE platform and is stored in a database. The SCA Reporter 
can query and retrieve information from the database and present the results in a comprehensive 
range of reports, including global monitoring, subscriber monitoring, P2P and traffic discovery 
statistics reports. 

The SCA Reporter is a valuable tool for understanding the habits and resource consumption of 
the applications and subscribers that use your network. It can also be used for judging the efficacy 
of various rules and the possible impact of their implementation on the network. 

The SCA Reporter is available only in a deployment with a database. You can generate reports 
by any one of the following methods: 

• Standalone Application 

• Command-Line Interface (CLI)⎯See Command-Line Interface (on page 6-1) 

• Tool of the SCA BB Console⎯See SCA Reporter as a Tool in SCA BB Console (on page B-1) 

The available reports can be presented using a variety of charts (for example, stacked bar and 
area) or in tabular form. The chart display can be adjusted for various presentation options (for 
example, 3D). Both tabular and chart reports can be exported to a file. The reports can also be 
modified by changing the values assigned to the parameters (for example, time boundaries), 
duplicate reports, export and save reports. 

After generating an initial report, you can generate reports using Command Line Interface (CLI) 
without using the GUI. 

SCA Reporter consists of visual components (known as "views"). The following are the views 
and the tasks that are completed in each view: 

• Templates View—Used to select a template, create a new report instance, and generate a 
report. 

• Properties View—Used to view parameters and values of the object in focus, which can be 
template groups, templates, report instances, and chart display parameters. You can also 
configure report instance and chart display parameters. 

• Report View—Used to view the appearance of the report when chart tab is selected and view 
the data when table tab is selected. When report is selected, you can navigate to the report 
instance which generated it. 
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• Progress View—Used to monitor reports executed or exported. You can view details and run 
in the background so you can continue working on other reports. 

Generating a report can be divided into three broad steps: 

Step 1 Create a report instance and execute the report from the Templates View. 

Step 2 Configure the parameters of the report in the Properties View. 

Step 3 Adjust the chart display and view reports in tabular or graphic form, using the Report View. 

Multiple reports can be generated simultaneously and later exported. While the reports are 
executing, you can monitor them and put them in the background by utilizing the Progress View. 

 

This chapter contains the following sections: 

• System Requirements 2-2 

• Installing the SCA Reporter 2-3 

• Accessing the SCA Reporter 2-7 

• Basic Reporter Terminology 2-8 

• Quick Start 2-9 
 
 

System Requirements 
The SCA Reporter GUI front end can be installed on any computer running Windows 98, 
Windows 2000, Windows NT, or Windows XP. 

The computer should have a minimum of 512 MB of memory. 1024 MB of memory are 
recommended. 
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Installing the SCA Reporter 
To install the SCA Reporter: 

 

Step 1 Double click the SCA Reporter installation file, SCAS Reporter 3.0.0 Setup.exe. 

 
Step 2 Click Next to continue the setup wizard. 
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Step 3 To accept the agreement, click "I accept" radio button. 

 
Step 4 Click Next. 

 
Step 5 (Optional) Click Browse and choose a different destination folder. 
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Step 6 Click Next. 

 
Step 7 (Optional) Enter a different Start Menu folder in the Start Menu Folder field. 

Step 8 Click Install. 
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Step 9 Wait until installation is complete. 

 
Step 10 Click Finish. 

The SCA Reporter is installed on the machine. 

 
 

Installing the SCA Reporter 
To uninstall the SCA Reporter: 

 

Step 1 Select Start > All Programs > Cisco SCAS > SCAS Reporter 3.0.0 > Uninstall. 
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Step 2 Click Yes. 

 
Step 3 Click OK. 

The SCA Reporter is uninstalled on the machine. 

 
 

Accessing the SCA Reporter 
You can access the SCA Reporter from the Start menu. 

To access the SCA Reporter from the Start Menu: 

 

Select Start > All Programs > Cisco SCAS > SCAS Reporter 3.0.0 > SCAS Reporter 3.0.0. 

 

 
 

Exiting the SCA Reporter 
To exit the SCA Reporter: 

 

Select File > Exit. 

SCA Reporter disconnects from the database and closes. 
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Basic Reporter Terminology 
This section defines terms and concepts that are necessary for understanding the SCA Reporter 
configuration and operation. 
 

Repository 
The part of the SCA Reporter configuration which is associated with a particular Cisco 
application. It consists of Template Groups and Repository Preferences. An example is “SCA BB 
3.0”. 
 

Template Group 
A collection of templates sharing some common theme. An example is “Subscriber Reports”. 
 

Template 
A specification of a particular Report, consisting of parameters and SQL code (which is not 
visible to the user). An example is “Global Bandwidth per Service”. 
 

Report 
Also known as Report Instance, is an instance of a template with some or all parameters having 
set values. 
 

Parameter 
An item of a template whose value determines some aspect of the Report Instance. An example is 
“From the last X hours”. 

• Some parameters are “Mandatory”⎯You cannot execute a report if there are mandatory 
parameters with no value. 

• Some parameters have a default value⎯A value which is used in case the user has not 
supplied one. 

 

Repository Preferences 
Configuration items which are dictated by the Repository. Normally they are considered 
mandatory in order to generate reports. The “SCA BB” repository has just one preference, which 
is the “IP of SCE for policy data” preference. 
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Quick Start 
When you initially use the SCA Reporter, you must set up and generate your first report, and 
then you can work with the report. 

To Generate Your First Report: 

 

Step 1 Configure a database for the Reporter to connect to (See Configuring a Database Connection (on 
page 3-1)), by adding a database connection, marking it as "Active", and clicking Apply. 

 
Step 2 Choose a value for the "SCE IP for policy data" preference (See Setting IP of SCE for Policy Data 

(on page 3-5)). 
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Step 3 Select a template in the Templates View and right click New (See Creating a New Report Instance 
(on page 4-2)). 

 
Step 4 Fill in values for mandatory and other report parameters (See Configuring Parameters of a Report 

Instance (on page 3-15)). 
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Step 5 Click Execute  to generate the report. 

 
Step 6 View your Report. 

 

 

To Work with a Report: 

 

Step 1 Click on "Services to View" parameter and check only "Email Services", "Generic IP Services", 
and "News Services". 
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Step 2 Click Execute  to re-generate the report. 

 
Step 3 Click "Chart Rendering" parameter and change from STACKED_BAR to STAIR (See 

Configuring Parameters of a Chart Display (on page 3-17)). 

Step 4 Click "Settings" parameter and change Ambient Light sliding scale. 

Step 5 Click OK. 
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Step 6 Export the report to a file by selecting File > Export (See Exporting Single or Multiple Reports 
(on page 5-19)). 

Step 7 Manage the reports by duplicating or renaming by selecting Menu > Duplicate. 

 
Step 8 Exit the SCA Reporter (See Exiting the SCA Reporter (on page 2-7)). 
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This chapter explains how to use the GUI, which includes navigating and configuring. 

This chapter contains the following sections: 

• Creating a Basic Configuration for the SCA Reporter 3-1 

• Creating an Advanced Configuration for the SCA Reporter 3-6 

• Navigating in the Reporter: Views 3-8 
 
 

Creating a Basic Configuration for the SCA Reporter 
It is necessary to create a basic configuration for the SCA Reporter, which includes connecting to 
a database, activating the database and setting the IP of the SCE platform for policy data. 

After the database is activated, you must select one IP address of an SCE device in the database. 
The choice is made for each repository, represented by a tab in the Template Preferences dialog. 
All options presented in the Templates View of the SCA Reporter (available packages, services, 
etc.) are determined by the Service Configuration currently applied to the configured SCE 
platform. Each report is generated according to the SCE device to which it is configured. In the 
sample configuration, there is only one SCE device connected to the database and one repository 
preference. 

You can also select Help > Welcome View, for guidance in creating a basic configuration. On the 
Welcome View are explanations, a short cut to the preferences wizard for activating a database, 
and another shortcut for setting IP of the SCE platform in the templates preference. In addition, 
there is a shortcut for starting the SCA Reporter. 
 

Configuring a Database Connection 
To activate a Database Connection: 

 

Step 1 Select Window > Preferences > Reporter, click Databases. 

The Databases Preferences window appears. 
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Step 2 To add a database, click the Add button. 

 
Step 3 To choose definition mode, select “Simple” or “Advanced” radio box. 

 



 

Chapter 3      Using the SCA Reporter 
 

Creating a Basic Configuration for the SCA Reporter 
 

 

Cisco Service Control Application Reporter User Guide   

OL-8411-01  3-3 
 

 

• Simple—Default values of driver and IP address. Choose Database Type and fill in 
Database IP address. 
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• Advanced—Specify all values. Fill in URL, Driver, User, and Password. 

 
Step 4 Check the "Activate this Database" check box. 

Step 5 Click Finish. 

 
Step 6 Click Apply. 

The system activates the database. 
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Note Clicking "Apply" is necessary to set the "IP of SCE for policy data" parameter (See Setting IP of SCE 
for policy data (on page 3-5)). 

 

 
 

Setting IP of SCE for Policy Data 
To Set IP of SCE platform for policy data: 

 

Step 1 Select Window > Preferences > Reporter > Templates. 

 
Step 2 Click the IP of the SCE for policy data to select the IP of SCE for the SCA BB Templates 

Repository. 

Step 3 Click Apply. 

The IP of the SCE platform is set for policy data. 

 

 
 

 
 

Note There may be more than one SCE platform, but you only choose one, when they all have the same 
policy data. 
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Note There may be cases where more than one Repository (set of templates) are available in the Reporter. 
Two tabs would be set in the Template Preferences when Setting IP for Policy data. In each, you choose 
one SCE platform. In this case, there would be two sets of Template Groups in the Templates View. 

 

 
 

Creating an Advanced Configuration for the SCA Reporter 
You can also create an advanced configuration to allow some functions of the SCA Reporter to 
be configurable. For example you can set the following: 

• Whether to send debug messages to log 

• Number of seconds to wait for a database connection 
 

Sending Debug Messages to Log 
To Send Debug Messages to Log: 

 

Step 1 Select Window > Preferences > Reporter click Configuration. 

 
Step 2 Check "Send Debug Messages to Log". 

Step 3 Click Apply. 

The system applies the preferences to the session. 

Warning: Sending debug messages to log can cause the log file to grow rapidly. 
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Configuring Seconds to Wait for Database Connection 
 

To Configure Seconds to Wait for a Database Connection: 

 

Step 1 Select Window > Preferences > Reporter > Configuration. 

 
Step 2 Type seconds to wait for a database connection. This parameter dictates how long The Reporter 

tries to connect to a database, in case the database does not respond immediately. 

Step 3 Click Apply. 

The system applies the preferences to the session. 

 
 

 
 

Note Back and Forward Icons can be used to navigate to previous configurations and return to the 
current window. 
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Navigating in the Reporter: Views 
You can navigate to Template Groups, Templates, and Report Instances in the Templates View. 
When you select an item, it is in focus and the Properties View shows the properties of the item. 

The Report View first appears when a report is generated. You can navigate to the report instance 
that generated the report by choosing the menu item Go to Report. 

The Templates and Properties Views are labeled, while the Report View contains reports with the 
name of each report on each upper tab. For example, the upper tab of a Report may be labeled 
"Global Hourly Usage per Volume Service". In the following figure, the Report Chart is displayed 
and the lower tab labeled "Chart" is selected (orange on top): 

Figure 3-1: Reporter Window with Views 
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You can also select the lower tab labeled "Table" to view the raw data as shown in the following 
figure: 

Figure 3-2: Report View - Table Tab 

 
 

Reporter Menu Items 
The following table contains the menus, options, and descriptions of the SCA Reporter Menu 
bar. 

Table 3-1  SCA Reporter Menu 

Menu Option Description Comments 

File Export Saves the report to a file. Opens Export Wizard and 
must choose Chart or Table. 
See Exporting Single or 
Multiple Reports (on page 5-
19). 

 Exit Closes the SCA Reporter.  

Window Preferences Install/Update Templates. See Installing and Upgrading 
SCA Reporter Templates (on 
page A-1). 

  Databases. Add, remove, or activate 
databases. See Configuring a 
Database Connection (on 
page 3-1). 
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Menu Option Description Comments 

  Templates. Create settings for installed 
templates. See Setting IP of 
SCE for Policy Data (on page 
3-5). 

  Configuration. Configure database 
connection timeout and 
debug messages to log. See  
Configuring Seconds to Wait 
for Database Connection (on 
page 3-7) and Sending Debug 
Messages to Log (on page 3-
6). 

Help Welcome Welcome View. Link to Databases and 
Templates Preferences. 

  Create a basic configuration. See Creating a Basic 
Configuration for the SCA 
Reporter (on page 3-1). 

 Help 
Contents 

Find Information. See Accessing On-Line Help 
(on page 3-21). 

 Search Help Find Information by entering text.  See Accessing On-Line Help 
(on page 3-21). 

 Manage 
Configuration 

Opens Product Configuration 
Window, which allows you to scan 
for updates, view installed history, 
show activities and add an extension 
location for browser. 

 

 Find and 
Install 

Opens Install/Update Wizard for 
new/current features. 

See Installing and Upgrading 
SCA Reporter Templates (on 
page A-1). 

 About SCA 
Reporter 

Current Version of SCA Reporter, 
license, plug-in details, confirmation 
details, confirmation details with 
system summary and error log.  

See Installing and Upgrading 
SCA Reporter Templates (on 
page A-1). 

 

 
 

Viewing Menu Items 
The GUI has a menu for each of the views. When the menu is clicked, all the available actions for 
that view appear. Menu items can be selected from the menu of each view, but there are icons on 
the tab of the view for frequently used actions. 

One way you can personalize the window layout is to detach a view checking the "Detached" 
menu item. You can also detach by dragging the view (See Window Layout). Some other 
available actions are: 

• Move—You can move a View or a Tab Group 

• Size—You can change the size of a pane from the left, right, top, or bottom 
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The following is an example of the Templates View after it has been detached from the Reporter. 

Figure 3-3: Detached Template View 

 
 

Help Menu 
The Help menu accesses a number of sub-menus. for the following sub-menus: 

• Welcome (See Creating a Basic Configuration for the SCA Reporter (on page 3-1)) 

• Help Contents (See Accessing On-Line Help (on page 3-21)) 

• Search (See Accessing On-Line Help (on page 3-21)) 

• Manage Configuration, Provides a description of the current configuration 

• Find and Install (See Installing and Upgrading SCA Reporter Templates (on page A-1)) 

• About SCAS Reporter 

• Plug-in Details (See Installing and Upgrading SCA Reporter Templates (on page A-1)) 
 

Properties View 
The Properties View always shows the properties of the item which is selected in the view which 
happens to be in focus. The following actions affect how the properties are presented: 

• Showing Advanced Properties—To view all the parameters or just mandatory parameters, 
click the Show Advanced Properties  icon . 

• Showing Categories—To view the parameters with their categories or without their 
categories, click the Show Categories  icon. 

• Resetting Parameter's Value—Clicking the Restore Default Value  icon while a parameter 
is highlighted, performs the following: 

• When a parameter is not mandatory, it is unset. 
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• Otherwise, when a parameter is mandatory and has a default value, it is reset to the default 
value. 

• Otherwise, the parameter is not changed. 

When you want to change the value of a parameter, you can select the parameter and re-configure 
it (See Configuring Parameters of a Report Instance (on page 3-15) and Configuring Parameters 
of a Chart Display (on page 3-17)). For example when you reconfigure "Services to View" by 
unchecking one of the services, re-execute the report for the new report to appear without the 
service. 

In the following example notice the actions and how they affect the displayed parameters in the 
Properties View. 

To shift the displayed parameters in the Properties View: 

 

Step 1 Generate a Report from the Template "Global Bandwidth per Service." 

The parameters in the Properties View are Chart Display parameters. 

 
Step 2 From the Report View, select Menu > Go to Report. 

The parameters that are displayed in the Properties View shifts from Chart Display parameters to 
Report Instance parameters. The report instance used to generate the report is selected and the 
View in focus shifts from the Report View to the Templates View. The mandatory parameters are 
displayed. 

 
Step 3 From the Properties View, select Menu > Show Advanced Properties. 
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All the parameters are displayed. 

 
Step 4 Click Show Categories to toggle viewing parameters with or without displaying categories. 

Category names are removed from the Properties View. 

 
Step 5 Click the "Services to View" parameter and uncheck "Generic TCP Service". 

Step 6 Click the "Check"  icon to select the new choices. 
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The "Services to View" parameter is updated. 

 
Step 7 Click the Execute icon from the Properties View. 

Generic TCP Service is removed from the legend and from the graph. 

 

 

  
 

Configuring Parameters 
When working with reports, you may want to assign values to report instance parameters. You 
would use a similar method to assign values to chart display parameters. The field is applied to 
the value of the parameter in different ways depending on the type of parameter. In report 
parameters, the new value is applied the next time the report is generated. In chart display 
parameters the value is applied as soon as the field is applied. 

The following are the  types of parameters: 

• No Value—When no value is assigned, "(not set)" appears. 
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• Free Text—Number or Character are typed. 

• Boolean—When a parameter of this type is selected, the value toggles between True and 
False. 

• Date—Pop-up dialog with date and time to be selected. 

• Single Choice—Drop-down menu  Icon is clicked to show the dialog box and a single 
choice is selected.  

• Multiple Choice—Pop-up dialog  Icon is clicked to show dialog boxes where more than 
one choice can be checked. 

The icons present in the Multiple Choice dialog window are described in the following table. 

Table 3-2 Parameter Option Icons 

Icon Option Description 

 Select All Select all boxes by checking all 

 Invert Selection Uncheck the checked boxes and the check the 
unchecked 

 Select None Uncheck all boxes 

 Cancel Exit Parameter Option Dialog without saving 

 OK Save and Exit Parameter Option Dialog 
 

 
 

 
 

Note Some parameters are mutually exclusive. "From the last Number hours" and "Starting after Date and 
Time" cannot both be implemented, even if they are both selected. 
For example, if you want to define the time frame to begin at a specified time, rather than to cover a 
specified number of hours previous, select "Starting after Date". When "From the last Number hours" is 
also chosen, the report time frame will be according to the Date and Time values, even when "From the 
last number hour" is selected. 

 

 
 

Configuring Parameters of a Report Instance 
The following is an example of assigning values to report instance parameters. 

To Assign Values to Report Instance Parameters: 

 

Step 1 From the Templates View, choose (or create) a report instance. 

The report instance is selected in the Templates View and the report parameters are displayed in 
the Properties View. 

Step 2 Choose the parameter to be modified. 
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Step 3 (Optional) Click Show Advanced Properties when the parameter is not in view. 

Step 4 Click the row of Traffic Direction parameter and select a value. 

Drop-down menu of parameter values appears and choice is made. 

 
Step 5 Click on the row of "Services to View" parameter and check the services you want to view. 

Step 6 Click the "Check"  icon to select the new choices. 

 
Step 7 Click the row of "Ending Before Date" parameter. 

 
Step 8 Select date and time and click OK. 

Step 9 Click Execute. 

The Report is generated with the configured values. 
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Configuring Parameters of a Chart Display 
You can configure chart display parameters which are those in the Look category of the 
Properties View. When you commit to the changes, the chart display updates. There are also 
adjustments that are made directly in the Report View (See Adjusting Chart Display (on page 5-
7)). 

The following is a table displays the Chart Display parameters and their descriptions: 

Table 3-3 Chart Display Parameters 

Categories Parameters Type Default Values Comments 

Look 3D Boolean False True, 
False 

Chart is Three dimensional when 
True. When False, the Look/3D 
Parameters are not displayed 

 Chart 
Rendering 

Single 
Choice 

Stacked 
Area 

Several 
Types 

Several ways that the chart can be 
presented. 

 Legend 
Visibility 

Boolean True True, 
False 

Legend is visible when True. 

Look/3D Oblique Boolean True True, 
False 

Rotation of a 3D chart so that there is 
always 90 degrees between x and y 
axes. 

 Settings Multiple 
Choice 

35, 45, 20, 
0, 1.0, 0.1, 
0.0, 0.0 

Ranges Sliding scales of characteristics such 
as rotation & elevation. One value is 
chosen from each 

 

To Assign Values to Chart Display Parameters: 

 

Step 1 From the Templates View, choose (or create) a report instance. 

The report instance is selected in the Templates View and the Report Definition parameters are 
displayed in the Properties View. 

Step 2 Click Execute. 

The Report is selected in the Report View and the Chart Display parameters are displayed in the 
Properties View. 

Step 3 Select the "Chart Rendering" field. From the drop-down list, choose the type of chart you want to 
render. 

The report is updated. 

 
Step 4 (Optional) To display the chart in 3D, click 3D parameter. 

The value changes from false to true and the 3D Look category parameters appear. 
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Step 5 (Optional) When the 3D parameter is set to true, select "Settings" parameter and set the 3D 
properties with the sliding scale. 

 
Step 6 Click OK. 

New values are assigned to the Settings parameter and changes can be viewed in the Report View. 

 

 
 

 
 

Note For Chart Rendering, you must choose one of the following values: BAR, STACKED_BAR, 
STACKED100_BAR,  SUPERIMPOSED_BAR,  AREA, STACKED_AREA, STACKED100_AREA, 
POLYLINE, STACKED_POLYLINE,  STACKED100_POLYLINE, SCATTER, STAIR, 
STACKED_STAIR, STACKED100_STAIR, SUMMED_STAIR, PIE. 

 

 
 

 
 

Note For Settings, you can choose from among the following sliding scales where the ranges are given: 
Rotation (-90 .. 90), Elevation (-90 .. 90), Depth (0..100), Depth Gap (0 .. 100), Zoom (0 .. 200), 
Ambient Light (0.. 100), Light Longitude (-90 .. 90), Light Latitude (-90 .. 90). 
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To configure Chart Display parameters - Look Category: 

 

Step 1 Set 3D to True. 

Step 2 Set Chart Rendering to "Stacked Bar". 

Step 3 Set Legend Visibility to True. 

Step 4 Drag Legend. 

 

 
 

 

 

 

Note When 3D is true, oblique and settings parameters can be configured.. 
 

To configure Chart Display Properties - Look/3D Category: 

 

Step 1 Set Oblique to true when the perspective of a 3D representation so the angle between the x axis 
and the y axis is always 90 degrees. 

Step 2 Configure settings. 
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Configuring Parameters: Example 
To configure Average Data by Hour: 

 

Step 1 Click the Report Instance. 

Mandatory parameters are visible in the Properties View. In this case, Average Data by Hour, 
SCE IP to View and Traffic Direction. When any of the parameters is not set, the report cannot be 
generated. 

 
Step 2 Configure Average Data by Hour to False. 
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Step 3 Select Menu > Execute report. 

 

 

 
 

Accessing On-Line Help 
You can access relevant parts of this user guide from the SCA Reporter. 

To access on-line help: 

 

From the Help menu, choose Help Contents. 

On-line help opens in a separate window. 

 

You can also search on-line help from within the current tool. 

To search on-line help: 

 

Step 1  From the Help menu, choose Search. 

A new area containing a Help tab is added next to the current tool. 

Step 2 Enter a word, phrase, or more complex search expression in the Search expression field. 

The Go button is enabled. 
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Click >> (Expand) for an explanation of how to construct search expressions. 

Step 3 Click Go. 

Help topics containing your search expression are listed under Local Help. 

Step 4 Click on a help topic to view its contents. 

You can bookmark topics for later reference. 

Step 5 By clicking the appropriate link at the bottom of the Help tab you can switch to: 

• All topics 

• Related topics 

• Bookmarks 
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This chapter contains the following sections: 

• Creating a New Report Instance 4-2 

• Duplicating an Existing Report Instance 4-3 

• Modifying an Existing Report Instance 4-3 

• Renaming an Existing Report Instance 4-5 

• Deleting a Report Instance 4-7 

The SCA Reporter supplies templates for a wide variety of reports, such as: 

• Global or package hourly or daily usage volume per service 

• Top server/clients/protocols/web hosts/email senders/newsgroups 

• Subscriber hourly or daily usage volume per service 

• Top P2P consumers/uploaders/downloaders/protocols 

• Global, package, or subscriber bandwidth per service 

The Properties View presents all the parameters of the report, both mandatory and non-mandatory, 
so that you can select the desired values. For example, if you want to see global bandwidth per 
service, create a new report from the Templates View of the SCA Reporter. The Properties View 
allows you to specify the desired service(s), traffic direction, and time frame (either start/end time 
or previous number of hours). For a complete description of all templates (see SCA Reporter 
Templates (on page C-1)). 

The report is defined in the Templates View. When the report is generated, it appears in the Report 
View. The Properties View displays the chart display parameters. To view the report instance 
parameters, go to report instance in the Templates View. This shifts the parameters that appear in 
the Properties View. You can duplicate the existing report instance. After that, modify the report 
instance by adjusting the chart display and report instance parameters. Renaming the original or 
duplicated report instance helps manage the reports. You can delete the report instance when you 
no longer require it (See Properties View (on page 3-11)). 

When you create a report, you select the desired report template and then specify values for the 
various report parameters. 
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The precise procedure for defining a report varies, depending on the report selected and the 
number of changes made to the basic report description. Also, the exact steps in selecting specific 
values for parameters may vary. Therefore, the following example is intended only as a general 
guide to the process of creating a new report instance. 
 
 

Creating a New Report Instance 
The following example illustrates defining the "Global Aggregated usage Volume per service" 
report. 

Figure 4-1: Templates View - Initial 

 
To create a new report: 

 

Step 1 Select from the Templates View "Global Monitoring" Group > "Global Aggregated usage Volume 
per Service" Template > New. 

A new report instance is displayed and the mandatory parameters  appear in the Properties View. 

 

Step 2 Click Execute  action. 

The report is generated with default values. The Report View and the Properties View appear. 
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When mandatory parameters are set, the Chart Display parameters (Look category) appear in the 
Properties View. An error may appear when the mandatory parameters are not all defined. 
 

Duplicating an Existing Report Instance 
You can duplicate an existing report instance. Use this feature when you want to create a report 
that is very similar to a report you have already defined, rather than starting "from scratch". 

To create a duplicate report instance: 

 

Step 1 From the Templates View, click on a Report Instance. 

Step 2 Click Menu > Duplicate.   

The report is duplicated. 

 
 

Modifying an Existing Report Instance 
You can locate and then modify an existing Report Definition. 

To modify an existing report instance: 

 

Step 1 Do one of the following: 

• Select an existing report from the Report View, click Menu > Go to Report. 

• Select a report instance from the Templates View. 

The existing report instance is selected in the Templates View and the report instance parameters 
are displayed in the Properties View. 

Step 2 Click Show Advanced Properties to view the mandatory parameters or all the parameters. 

One of the following sets of data is viewed in the Properties View. 
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• Mandatory Parameters.  

 
• All of the Parameters. 

 
Step 3 Click Show Categories to view the parameters without the Categories in the Properties View. 
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The Categories are not displayed. 

 
Step 4 Edit the parameters by clicking on the row of the parameter and commit to the changes. Change 

the Services to view; Uncheck "Generic UDP Service" and "P2P Service" & Check " Service". 

The changes are saved for the next time the report is executed. 

Step 5 Click Execute . 

The report is regenerated and the Report Views appears.  The Chart Display Parameters are 
displayed in the Properties View. 

 

 

 
 

Renaming an Existing Report Instance 
You can rename an existing report instance. This is useful when the same report is generated on a 
regular basis. The date or other identifying information can be included in the name of the report. 

To rename a report instance: 

 

Step 1 From the Templates View, choose a report instance. 
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The Report Instance is highlighted. 

Step 2 Click Menu > Rename. 

The Report Instance is highlighted and the Report Instance name can be edited. 

 
Step 3 Type in a new name and press Enter. 
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The report instance is listed as the new name. 

 

 

 
 

Deleting a Report Instance 
You can delete a report instance. 

To delete a report instance: 

 

Step 1 From the Templates View, choose a report instance, (or several instances, by using the CTRL key 
when selecting). 

Step 2 Click Menu > Delete. 

Each Report Instance is deleted. 
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Note You can select several report instances by holding Control while clicking them, and then delete them all 
at once. 
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While you use the Templates View to define and generate a report, the generated report appears in 
the Report View of the SCA Reporter. The report is displayed in chart or tabular form. You can 
adjust a chart display, save it, and export it to a file. 

This chapter contains the following sections: 

• Report Actions 5-1 

• Generating a Report 5-3 

• Viewing Reports 5-5 

• Adjusting Chart Display 5-7 

• Exporting Single or Multiple Reports 5-19 
 
 

Report Actions 
The Views found on the SCA Reporter, display menu items. Some available commonly used 
actions have icons for easy  navigation. 

The Actions and their icons, where relevant, are described in the following table. 

Table 5-1 Actions 

Action Icon Description Comments 

Home  Opens Welcome View  

Navigate to 
Previous Topic 

 When displayed, supports 
navigation to previous topic. 

Preferences dialog. 

Navigate to Next 
Topic 

 When displayed, supports 
navigation to next topic. 

Preferences dialog. 

Minimize  Minimizes View. Common to all Views. 

Restore  Restores View. Common to all Views. 

Maximize  Maximizes View. Common to all Views. 
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Action Icon Description Comments 

Close  Closes View. Common to all Views -  Red when 
curser is on it. 

Menu  Displays all the available actions 
for the View. 

Common to all Views - Has different 
Actions depending on the View.  

Execute  Generates the selected report. Properties and Templates View. 

New or 

Report (From 
Legend) 

 Creates new Report Instance. Templates View - When Report 
Template is selected, the icon is new. 

Report View - When Legend Item 
right clicked, Subset of Template 
Groups and Templates View appears, 
choose template & click ok, then the 
report instance is created (modified) 

 may appear when New Report 
not available for instance, when 
Template Group is selected instead of 
Template. 

Refresh  Refreshes Templates View so only 
the Report Groups are displayed 

Templates View. 

New Cmd  Opens a Window with CLI for the 
report. 

Templates View- The CLI 
commands are placed on the 
clipboard and can be pasted on the 
Notepad and edited and then 
executed from Shell or Command 
Prompt. 

Delete No Icon Deletes the report. Templates View. 

Duplicate No Icon Creates a copy of the report 
instance. 

Templates View. 

Rename No Icon Highlights the report instance so 
you can rename it. 

Templates View. 

Show Categories  Toggles between displaying 
parameters with and without 
categories. 

Properties View. 

Show Advanced 
Properties  Toggles between displaying 

mandatory parameters and all 
parameters. 

Properties View. 

Restore Default 
Value  Restores parameter default value. Properties View - Default values can 

be a value or "not set". Mandatory 
parameters have a value. Default 
values of non-mandatory parameters 
may have the value "not set". 

Go to Report No Icon Navigates from selected Report in 
Report View to Report Instance in 
Template View.  

Report View. 
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Action Icon Description Comments 

Export Raw Data No Icon Opens browsers to save the report 
data.  

Report View. 

Show List  Indicator that there are many 
reports that have been executed. 
When you click, those reports are 
listed. 

Report View - To display a report, 
choose from the bold reports. the 
number refers to how many reports 
are not in view. In this example there 
are 3. 

Preferences No Icon Dialog appears for choosing 
preference for whether to show 
system tasks or not. Sleeping 
(waiting) tasks are shown in both 
cases. 

Progress View  

 - Icon which appears when there 
are system tasks running. 

Remove All 
Finished Tasks  Removes all tasks. Progress View. 

 
 
 

 
 

Generating a Report 
You can generate a report that has already been defined. The reports are found in the Templates 
View. You can duplicate , modify, rename or delete the reports (See Defining the Report (on page 
4-1)). You can also generate multiple reports, put the process in the background, and continue 
working on other reports. 

To Generate a Report When Report Instance is selected: 

 

Step 1 From the Templates View, click on a Report Instance. 

The report instance parameters are displayed in the Properties View. 

Step 2 Click Execute. 

The report is re-generated and appears in the Report View. 

 

To generate Multiple Reports: 

 

Step 1 From Templates View, select the Report Instances while pressing Control. 

The selected report instances are highlighted. 

Step 2 Click Execute. 
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Progress dialog appears while reports are being generated. 

 
Step 3 Do one of the following: 

• Wait until tasks end while viewing system task status at the bottom right corner of the 
Reporter. 

 
• Click Details. 

 
The status of all the reports that are being generated is displayed. 

• Click Run in Background. 

The reports continue running in the background. When the system completes the tasks, the 
reports are displayed in the Report View.  
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Note It is possible to interrupt a running report by clicking Cancel in its Progress View. It sometimes takes a 
while for the Database Server to acknowledge a cancel request, but you can still move the cancelled 
report to the background and continue your work uninterrupted. 

 
 

Viewing Reports 
There are two possible ways of viewing reports in the Report View; chart and table. Click the 
appropriate tab located on the left side of each report to select the desired view. 
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The table is useful for locating specific information. 
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Adjusting Chart Display 
You can change the appearance and type of any report chart by modifying chart display 
parameters, such as 3D and chart rendering. Some other possibilities for changing the appearance 
are the following: 

• Dragging the legend to a different spot in the report. 

• Hiding the legend, while the graph remains the same. 

• Hiding items from the legend, causing the corresponding part of the graph to be removed from 
view. 

• Zoom in or out, drag the graph so that the desired section is in focus. 

To adjust the chart display: 

 

Step 1 Select a Report. 
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Step 2 Configure the Chart Display parameters by changing 3D from false to true. 

The chart display adjusts to display a 3D chart and the Look/3D category  appears in the 
Properties View. 

 
Step 3 Click on Settings parameter and then click on box on the side. 
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Step 4 Move the Ambient Light sliding scale to the right, to lighten the graph. 

 

 

To adjust the 3D Properties and view outcome: 

 

Step 1 Change Chart Display parameter, Oblique to false. 

The angle between the x and y axes is changed from 90 degrees. 
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Step 2 Change "Rotation" sliding scale in the Settings parameter from 35° to 65° and click OK. 

 
Step 3 Change Elevation from 45° to 30° and click OK. 

 
Step 4 Change Depth from 20 to 60 and click OK. 
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Step 5 Change Depth Gap from 0 to 90 and click OK. 

 

 

To Choose Type of chart: 

 

Step 1 Set Chart Display parameter, Chart rendering to Pie Chart. 
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Step 2 Set Chart Display parameter, Chart rendering to Scatter. 

 

 

To Zoom-In - 2D graph: 

 

Mark off a rectangle by dragging the mouse over the chart. 
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A plus icon appears and the view zooms in. 

 

 
 

 
 

Note When a small rectangle is marked, the zoom in is a large magnification. When a large rectangle is 
marked, the magnification is relatively small. 

 

To Zoom Out - 2D graph: 

 

Mark off a rectangle by dragging the mouse over the chart while holding Shift. 

A minus icon appears and the view zooms out. 

 
The graph zooms out. 
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Note Zooming works similarly for 3D. 
 

To Drag the Graph: 

 

Step 1 Zoom in to the top part of a chart. 

 
Step 2 To move the chart down, right click, while dragging the chart.  
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The graph moves up and the bottom of the chart is viewed. 
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To Hide Services: 

 

Right Click on the "Streaming Service" in the legend and choose Hide. 
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The service is dimmed out and the service is removed from the chart. 

 

 

 

To Show Services that have been Hidden: 

 

Step 1 Right Click on the "Streaming Service" in the legend and choose Show. 

The service re-appears on the chart and in the legend. 
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To Move Legend: 

 

Step 1 Right click on the area where the legend is located, while dragging. 

 

 

 
 

 
 

Note Particular legend items are displayed in the same color each time the Reporter is run.  

 

 
 



 

Chapter 5      Working with Reports 
 

Exporting Single or Multiple Reports 
 

 

Cisco Service Control Application Reporter User Guide   

OL-8411-01  5-19 
 

 

Exporting Single or Multiple Reports 
Use this option to export charts to most graphic formats. This option can also be used to export 
tables to csv or quoted csv format, which can be opened as spreadsheets. Multiple reports are 
exported by checking the reports in the dialog box of the wizard. 

To export a report chart or table: 

 

Step 1 After executing one or more report, click File > Export. 

 
Step 2 Choose Chart or Table. 

Step 3 Click Next. 
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Step 4 Check one or or more of the Available Reports. 

 
Step 5 (Optional) Change the default destination directory in the Output folder field. 

Step 6 Click Next. 

Step 7 Do one of the following: 

• (For Chart) Choose File type: jpeg or png, and configure Image width and height in pixels. 

• (For Table) Choose CSV or quoted CSV. 
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Chart Format: 

 
Table Format: 

 
Step 8 Click Finish. 

Each file is created and saved in the output folder configured. 
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This chapter describes the various ways of using the Service Control Reporter Command-Line 
Interface (CLI) for executing the SCAS Reporter features, including the syntax, switches, and 
options of the application. 

This chapter contains the following sections: 

• Overview of Reporter Command-Line Interface 6-1 

• Syntax and Usage 6-1 
 
 

Overview of Reporter Command-Line Interface 
The Reporter Command-Line Interface (CLI) is based on a command-line application that 
complements the functionality of the SCA Reporter GUI. The CLI provides capabilities and 
flexibility beyond that of its SCA Reporter GUI counterpart and can be integrated into third-
party applications to generate usage and statistical based output. A report must first be executed to 
verify that the report is satisfactory. Since the CLI utilizes the name of the report instance that is 
generated by the GUI. Once the initial report is generated, you can change the parameters without 
using the GUI. 
 

Syntax and Usage 
The SCA Reporter is an application that can be executed as a command-line version which 
accepts input passed as parameters. Once a report is generated, click Menu > Show Cmd in the 
Templates View to create the initial CLI Command with the name of the report. The database 
information and the SCE IP parameters are included along with the configured parameters for the 
report instance. 

The command is automatically copied to the clipboard so you can paste in a command file shell or 
in a command window to be executed with some minor changes. For automated reporting other 
switches are added. For example, the filename to save the data and the format that it is to be saved 
are not included in the CLI for this report. The format would indicate if the report is to be in 
graphic (jpeg) or tabular (csv) form. 

Also not all parameters that exist in the original report are included in the "params" switch. When 
a parameter is not specifically listed in the CLI invocation, the value is taken from the report from 
which the command is based. 
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Command-Line Usage 
The following is an example of a command line for invoking the SCAS Reporter application: 

 
reportercmd -report "Global Bandwidth per Service #1" -dbdriver 
"com.mysql.jdbc.Driver" -dburl 
"jdbc:mysql://127.0.0.1:3306/apricot" -dbuser "pqb_admin" -
dbpassword "pqb_admin" -policysce "10.1.12.85" -params 
"numhours=240000000;seip=10.1.12.85;avgdata=true;link=Link 0,Link 
1;traficdir=Both Directions;services=Messaging Service,Generic UDP 
Service,Generic TCP Service,News Service,FTP Service,Browsing 
Service,Default Service" -o "myfile" -format "jpeg" 

The following are the switches for the non-parameter arguments that must be added: 
 

-o "filename" -format "jpeg or csv" 

To Generate Reporter Commands: 

 

Step 1 Select a Report Instance and execute the report from the Templates View. 

The report is generated. 

Step 2 (Optional) Reconfigure report instance and chart display parameters so you have a satisfactory 
report instance on which to base your CLI. 

 
Step 3 Select Menu > Show Cmd. 

 
Step 4 Click OK. 

The command with all the switches and parameters, is placed on the clipboard. 
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Step 5 Do one of the following: 

• Open a file from which to execute the Command from Shell and save the file in the 
Reporter directory. 

• Open a Command Window from which to execute the CLI command and change the 
directory to the Reporter directory. 

Step 6 Paste the clipboard contents. 

The command is pasted in the file or in the Command line. 

Step 7 Add the following mandatory flags:  
• -o "filename" 

• -format "jpeg or csv" 

Step 8 Change parameters as required. For example you may want to change the "numhours" parameter. 

 
Step 9 Execute the command for automated reporting. 

The exported file is saved in the defined directory with a time stamp appended to the name of the 
report. 

 
 

Command-Line Switches 
The following are switches in the command line for invoking the SCAS Reporter application: 

• -report 

• -dbdriver 

• -dburl 

• -dbuser 

• -dbpassword  

• -policysce 

• -params 

• -o 

• -format 
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Command-Line Options 
The following table describes the options of the command line for invoking the SCA Reporter 
application: 

Table 6-1 Command-Line Options for SCA Reporter Application 

Option Action by SCA Reporter Comments 

-report "report-
name" 

Generates report using report-name. Use this parameter when 
generating a report from one of 
the Report Instances. 

-dbdriver "db-
driver" 

Driver for the database. Same database that is 
configured in the SCA 
Reporter. 

-dburl "db-url" URL for the database.  

-dbuser "db-user" User for the database.  

-dbpassword "db-
password" 

Password for the database.  

-policysce "IP of 
SCE for policy 
data" 

(Required) Configuration of IP of SCE for 
policy data of Templates. 

Same IP of SCE for policy data 
that is configured in the SCA 
Reporter. 

-params 
"numhours=,..." 

Parameter from Properties View. When a particular parameter is 
not listed, the default value is 
used. 

-o "filename" (Required) Name of file to which to direct 
output. 

If the filename already exists, 
the original file is overwritten. 

-format "jpeg" (Required) Generates report as a chart or 
table in the specified report-format. 

-format "csv" used in 
spreadsheets for table data. 
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This chapter describes the how to install and upgrade SCA Reporter Templates. 
 

Installing the Reporter Templates 
To install the Reporter Templates: 

 

Step 1 Select Help > Find and Install. 

 
Step 2 Check "Search for new feature to install" and select Next. 

 

A P P E N D I X  A  
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Step 3 Press Next. 

Step 4 Press "New archived site…" and browse for the site distributed with the release. 

The file is highlighted in the browser. The file is according to the naming convention; 
SCAS_bb_template_B<build>.zip. For example, the file may be named  
SCAS_bb_template_3.0.0B8.zip. 

 
 

Step 5 Select the zipped file and press Open. 

"Edit Local Site" dialog appears with the zip name and the URL with the content. 

 
Step 6 Press on OK. 
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Step 7 Press Finish. 

 
Step 8 Accept the agreement and Click Next. 

Updates dialog appears with the available installed features for that site. Select the required 
feature which should is named like “SCAS BB Templates .<build>". For example the file may be 
named "SCAS BB Template 3.0.0.8". 

 
Step 9 (Optional) Click Change Location and browse to install features in another location. 
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Step 10 Click Finish. 

 
Step 11 Press Install or Install All. 

 
Step 12 Press Yes and wait for the application to come up. 

Computer restarts. 

Step 13 Click Help > About SCAS Reporter > Plug-in details. 

 
Step 14  Verify that the new installed version appears on the Reporter plug-in list and click OK. 

The Plug-in Window closes. 
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Upgrading the Reporter Templates 
To upgrade the Reporter Templates: 

 

Step 1 Select Help > Find and Install. 

 
Step 2 Click Finish. 

One of the following occurs: 

• There are no updates. 

 
• There are updates. 

The wizard appears (See Installing the Reporter Templates (on page A-1)). 
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This chapter describes the SCA Reporter as a tool in the SCA BB Console. For more 
information on the SCA BB Console, see Cisco Service Control Application for Broadband User 
Guide. 
 

Accessing the SCA Reporter 
You can access the SCA Reporter as a tool in the SCA BB Console. 

To access the SCA Reporter from within the SCA BB Console: 

 

Step 1 Select Start > All Programs > Cisco SCAS > SCAS BB Console 3.0.0 > SCAS BB Console 
3.0.0. 

A P P E N D I X  B  

SCA Reporter as a Tool in SCA BB Console 
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The Initial Perspective appears. 

 
Step 2 Select Tools> Reporter. 
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The Reporter perspective appears. 
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Navigating in the SCA BB Console: Perspectives 
The SCA Reporter is a tool in the SCA BB Console and is accessed by opening a Perspective. 

The Reporter GUI has a standard toolbar and menu bar. Underneath the menu bar is the 
perspective bar. When you open a perspective, a button is added to the perspective bar. To switch 
between open tools, simply click on the appropriate button on the perspective bar. The Templates 
View is the default view for the Reporter Perspective. When a report is executed, the Report and 
Properties Views are also displayed. 

The configuration and operation of the SCA Reporter as a tool in the SCA BB Console is 
identical to its configuration and operation as a standalone. This includes navigation (See 
Navigating in the Reporter: Views (on page 3-8)).  

Figure B-1: SCA BB Console Perspective 

 
 

 

 
 

Note The title of the Console Perspective shows the active perspective and the active service configuration. 
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This chapter describes the SCA Reporter Templates. 
 

Overview of Report Templates 
The SCA Reporter provides groups of templates from which to generate reports. Each template 
allows you to create new report instances. Default filter values are assigned to the parameters, 
some of which are common to all the instances in a given group. You can impose additional 
constraints by configuring the parameters.  

 

 
 

Note The default filters are the default values initially applied to the parameters. When generating reports, 
you re-configure parameters. In order to reset the parameters to their default values, select parameter 
and click Restore Default Value. Mandatory parameters are the ones that are viewed the initial time a 
report is executed and they must be set. Non-mandatory parameters may be assigned a value of "not 
set". To view all the parameters, click Show Advanced Properties. 

 

A P P E N D I X  C  

SCA Reporter Templates 
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You generate a report instance by selecting a report template from the list of available groups in 
the Templates View. The figure below shows a selected report instance "Global Bandwidth per 
Service #1" which was generated from the "Global Bandwidth per Service" template in the 
"Global Monitoring" group. The Properties View displays the mandatory parameters of the report 
instance "Global Bandwidth per Service #1". 

Figure C-1: Templates View 

 
At a high level, the system provides two categories of reports: 

• Monitoring reports—Provide insight as to how network resources are utilized according to the 
configured services in the system at various granularities (global, package, subscriber). 

• Traffic Discovery reports—Provide statistical information on network activity and help 
identify the characteristics of the traffic traversing the network. 

The SCA Reporter provides the following parameters that are common for all reports: 

Table C-1 Common Parameters for All Reports 

Parameter Field 
Type 

Default Mandatory Remembered Comments 

SCE IP Single 
Choice 

not set √ √ IP of specific SCE platform 

Starting After 
Date 

Time/Date not set    

Ending 
Before Date 

Time/Date not set   When not set, the report is 
bound to the current time. 

From the Last 
Number of 
Hours/Days 

Free Text- 
Number 

 24 √  Ignored when all three time 
boundaries parameters are 
set. 
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• SCE IP—All reports include a parameter which enables filtering to a specific SCE platform. 
This parameter is mandatory and set to be remembered. Remembered means that once this 
parameter is set, it is set for all the additional reports which are created after.  

• Time Boundaries Parameters—The following time boundaries parameters are included for all 
reports except for Top Subscribers, Top Talkers and Relative Consumption of Top 
Subscribers. 

• Starting After Date 

• Ending Before Date 

• From the Last Number of Hours/Days 

The parameter, "From the last number of hours/days" is set to a default value in all the reports. 
When all three time boundaries parameters are set, the "last number of hours" is ignored. 
When the parameter "Ending before date" is not set, the report is bound to the current time. 

The following subsections describe the mainstream reports in each category.  
 

Monitoring Reports 
Monitoring reports provide information on the distribution and consumption of network 
resources. Reports in this category are useful for the understanding of how the network is used at 
different granularities (such as for the entire link, or for traffic generated by all subscribers in a 
particular package counter, or for traffic generated by a particular subscriber). These reports are 
critical for the tuning of the Service Control solution’s configuration according to the changing 
network patterns. 

Monitoring RDRs are created from the Link, Subscriber, and Package RDRs (that are generated 
by the SCE platform). These RDRs provide periodic usage information (at the various 
granularities) that is processed according to the selected report template to provide the final 
report. 

Reports of this type typically show a specific metric for a set of service counters at a selected 
granularity. For example, bandwidth for P2P and Browsing service counters at a link granularity, 
or volume for the Streaming service counter for subscribers in the Gold package counter. 

Selecting the service counters on which to report is done via the SCA Reporter. The available 
service counters are those defined in the service configuration of the SCE platform from which 
the reports are generated. 
 

Granularity 
A report’s granularity controls what part of the traffic the selected report addresses. The following 
granularities are supported: 

• Global—Provides visibility into all traffic processed by the SCE platforms being reported on. 
Use this global granularity to view the global distribution of network resources (for example, 
total P2P bandwidth for the last 24 hours) 
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• Package—Reports on traffic mapped to subscribers in a particular package counter. Use 
package granularity to monitor how network resources are used by subscribers assigned to a 
particular package counter (for example, the total volume of streaming traffic for all 
subscribers assigned to the Gold package counter in the last 10 days). Note that to generate 
package counter reports, subscribers must be defined (in any of the subscriber modes) and 
assigned to a particular package. In the Cisco Service Control Application for Broadband User 
Guide, see Managing Subscribers for a description of how to manage subscribers and Using 
the Service Configuration Editor: Traffic Control  for a description of how to define different 
packages in the system. 

• Subscriber—Provides insight into the activity of a single subscriber as defined in the Service 
Control solution. Use subscriber granularity to view how a particular subscriber is utilizing 
network resources (for example, the number of P2P sessions generated by subscriber xyz for 
each hour during the last 12 hours). Subscriber reports are available for those subscribers 
flagged for real-time reporting. (See Cisco Service Control Application for Broadband User 
Guide, Using the Service Configuration Editor: Traffic Accounting and Reporting for a 
description of managing real-time subscriber reporting.) 

Each report template generates a report in a specific granularity (global, package, or subscriber). 
Each type of report is accessible through the corresponding report template group: 

• Global reports are accessible through the Global Monitoring (on page C-9) group. 

• Package reports are accessible through the Package Monitoring (on page C-11) group. 

• Subscriber reports are accessible through the Subscriber Monitoring (on page C-15) group. 
 

Metrics 
A metric is the statistic that is being reported on. The following metrics are available: 

• Bandwidth—Represents the total Kilobits-per-second (Kbps) consumed by the selected 
services. Bandwidth graphs are presented by default as stacked-area (where each area/series 
indicates the bandwidth of a particular service). 
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When generating a bandwidth report it is possible to select the direction: upstream or 
downstream (to focus on a particular direction), or both (default). An additional option is to 
perform an hourly average of samples so as to create a single sample for each hour. This is 
recommended when generating a report for more than several hours, in which case a single 
sample per hour is usually sufficient and reduces the number of samples displayed (it also 
increases performance and improves the visualization of the data). 

Figure C-2: Global Bandwidth Per Service 

 
• Volume—Represents the total volume (in kilobytes or megabytes) for a specific period of 

time, for the selected service counters. As opposed to the bandwidth metric (which provides 
normalized volume over time), volume reports provide the total volume consumed, grouped 
by specific time durations. Volume graphs are presented by default as stacked bar-charts 
(where each bar/series indicates the volume of a particular service counter). 
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Volume reports accumulated usage either for specific durations of time (hours or days), or for 
the entire duration of the report. An example of a report that groups volume by duration is 
Global Hourly Usage Volume, which generates a bar that accounts for the total volume 
consumed (by each service counter) during each hour of the selected time frame. As a 
different example, the Global Aggregated Usage Volume per Service report accounts for all 
volume of each service counter for the entire time frame of the report. 

Figure C-3: Global Aggregated Usage Volume Per Service 

 
• Sessions—Counts the number of sessions. A session is a single network transaction (for 

example, RTSP stream or P2P file download). Sessions graphs are generated by default as 
stacked-bar charts (where each bar/series indicates the total number of sessions of a 
particular service counter). 
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Similar to volume reports, sessions reports can be grouped into specific durations (hours or 
days), so as to account for the total number of sessions in a particular hour/day consumed by a 
particular service counter. 

Figure C-4: Global Hourly Usage Sessions Per Service 

 
 

Traffic Discovery Reports 
Traffic discovery reports provide raw statistics for analyzing network activities. They are useful 
for obtaining statistics on the general activity in the IP network, and are the key for the definition 
of the service configuration of the system. 

The generation of traffic discovery reports is based on Transaction RDRs (generated by the SCE 
platform). These sampled RDRs provide the statistical information from which the various Traffic 
Discovery histograms and charts are created. 

Traffic Discovery reports generate histograms and distribution charts that are grouped by the 
selected criteria and ordered by the selected order-parameter. For example: Top Protocols sorted 
by Total Volume, or Top Web-hosts sorted by Hit-Count. 
 

Criteria 
Each report template focuses on a particular criterion based on layers 3–7, such as:  

• Top Servers/Client IP addresses 

• Top Server/Client Port numbers 

• Top HTTP web-hosts 

• Top NNTP news-groups 
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Report templates focusing on statistics from layers 3 and 4 (for example, IP addresses and port 
numbers) are found in Traffic Discovery - Statistics (on page C-18). Report templates focusing on 
application- and protocol-specific information are in Mail and News Reports (on page C-26). 

The following is an example of a report on Top Servers, which focuses on IP address. 

Figure C-5: Top Servers - Focusing on IP Addresses 

 
 
 

Order Parameter 
The order parameter indicates the parameter that the report will be sorted by. Available parameters 
are: 

• Total Volume—Extrapolated total volume (both upstream and downstream) 

• Upstream Volume—Extrapolated upstream volume 

• Downstream Volume—Extrapolated downstream volume 

• Hit-Counts—Extrapolated Number of transactions 

Each report can be limited to a specific number of results, which allows focusing on the top areas 
of activity (according to the selected order-parameter), as illustrated in the following two 
examples. 

• Top Newsgroups Ordered by Volume 

• Top Protocols Ordered by Volume 
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Global Monitoring 
Use the Global Monitoring group of reports to view statistics regarding the traffic bandwidth or 
volume that was consumed. The bandwidth/volume consumption can be presented per service for 
the entire link. 

Table C-2 Common Parameters for Global Monitoring Group 

Parameter Field Type Default Mandatory Remembered Comments 

Link to 
Focus 

Multiple 
Choice 

not set   List of available links to 
focus. 

Services to 
View 

Multiple 
Choice 

not set √  List of service counters 
available for this subscriber 
domain. All services, when 
not set. 

 

 
 

Global Bandwidth per Service 
For a given time frame, Global Bandwidth per Service shows the distribution of bandwidth 
among the different services defined in the system for all traffic, regardless of subscriber or 
package. 

Table C-3 Global Bandwidth per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 

Average 
data by hour 

Boolean True √  Select option or not. 
If this option is selected, a 
single value is used for each 
hour: Average of all 
samples. This option is 
recommended when 
generating the report for 24 
or more hours. 
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Global Aggregated Usage Volume per Service 
For a given time frame, Global Aggregated Usage Volume per Service shows the most popular 
Service counter. It shows, for the selected time frame, the total amount of traffic volume 
(upstream and downstream) for each service counter (for all traffic, regardless of subscriber or 
package). 

Table C-4 Global Aggregated Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 

 

 
 

Global Hourly Usage Volume per Service 
For a given time frame, Global Hourly Usage Volume per Service shows the distribution of 
volume between the different service counters defined in the system, grouped by hour. 

Table C-5 Global Hourly Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

 

 
 

Global Hourly Aggregated Minutes per Service 
For a given time frame, Global Hourly Aggregated Minutes per Service shows the total number of 
minutes spent for service counters defined in the system, grouped by hour. 

See Global Monitoring (on page C-9) for a table of common parameters for the Global 
Monitoring group. 
 

Global Hourly Usage Sessions per Service 
For a given time frame, Global Hourly Usage Sessions per Service shows the distribution of 
sessions between the different service counters defined in the system, grouped by hour. 

See Global Monitoring (on page C-9) for a table of parameters for the Global Monitoring group. 
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Global Concurrent Session per Service 
For a given time frame, Global Concurrent Session per Service shows the distribution of 
concurrent sessions between the different service counters defined in the system 

See Global Monitoring (on page C-9) for a table of parameters for the Global Monitoring group. 
 

Global Daily Usage Sessions per Service 
For a given time frame, Global Daily Usage Sessions per Service shows the distribution of 
sessions between the different service counters defined in the system, grouped by day. 

See Global Monitoring (on page C-9) for a table of parameters for the Global Monitoring group. 
 

Global Daily Usage Volume per Service 
For a given time frame, Global Daily Usage Volume per Service shows the distribution of volume 
between the different service counters defined in the system, grouped by day. 

Table C-6 Global Daily Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

 

 
 

Package Monitoring 
Use Package Monitoring group of reports to view statistics of bandwidth or volume of traffic used 
by a package. The reports are provided per service counter for the total volume used by the 
package. The volume consumption can be presented per service for package. 

Table C-7 Common Parameters for Package Monitoring Group 

Parameter Field Type Default Mandatory Remembered Comments 

Services to 
view 

Multiple 
Choice 

not set   List of services available 
for this subscriber domain. 
All services, when not set. 

Package Single 
Choice 

not set √  Select one of the package 
counters: Default Package 
or Unknown Subscriber 
Traffic. 
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Package Bandwidth per Service 
For a given time frame, Package Bandwidth per Service shows the distribution of bandwidth 
among the different service counters defined in the system for all subscribers belonging to a 
particular package. 

Table C-8 Package Bandwidth per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

Average 
data by hour 

Boolean True √  Select option or not. 
If this option is selected, a 
single value is used for 
each hour: Average of all 
samples. This option is 
recommended when 
generating the report for 24 
or more hours. 

 

 
 

Package Aggregated Usage Volume per Service 
For a given time frame, Package Aggregated Usage Volume per Service shows the most popular 
Service counter for a specific package counter. It shows, for the selected time frame, the total 
amount of traffic volume (upstream and downstream) for each service counter (for subscribers in 
a specific package). 

Table C-9 Package Aggregated Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 
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Package Hourly Usage Volume per Service 
For a given time frame, Package Hourly Usage Volume per Service shows the distribution of 
volume between the different service counters defined in the system, for the traffic of subscribers 
in a specific package counter, grouped by hour. 

Table C-10 Package Hourly Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 

 

 
 

Package Hourly Aggregated Minutes per Service 
For a given time frame, Package Hourly Aggregated Minutes per Service shows the total number 
of minutes spent for service counters for a specific package counter defined in the system, 
grouped by hour. 

Table C-11 Package Hourly Aggregated Minutes per Service  

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 

 

 
 

Package Hourly Usage Sessions per Service 
For a given time frame, Package Hourly Usage Sessions per Service shows the distribution of 
sessions between the different service counters defined in the system, for the traffic of subscribers 
in a specific package, grouped by hour. 

See Package Monitoring (on page C-11) for a table of common parameters for the Package 
Monitoring group. 
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Package Concurrent Session per Service 
For a given time frame, Package Concurrent Session per Service shows the distribution of 
concurrent sessions between the different Service Counters for a specific package counter defined 
in the system 

Table C-12 Package Concurrent Session per Service  

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 

 

 
 

Package Daily Usage Sessions per Service 
For a given time frame, Package Daily Usage Sessions per Service shows the distribution of 
sessions between the different service counters defined in the system, for the traffic of subscribers 
in a specific package counter, grouped by day. 

See Package Monitoring (on page C-11) for a table of common parameters for the Package 
Monitoring group. 
 

Package Daily Usage Volume per Service 
For a given time frame, Package Daily Usage Volume per Service shows the distribution of 
volume between the different service counters defined in the system, for the traffic of subscribers 
in a specific package counter, grouped by day. 

Table C-13 Package Daily Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: Upstream, 
Downstream, or Both 
Directions. 
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Subscriber Monitoring 
Use the Subscriber Monitoring group of reports to view statistics regarding the bandwidth or 
volume of traffic used by the subscriber. The reports are provided per service counter for the total 
volume consumed by the subscriber. The Top Subscribers report identifies the subscribers that 
consume the largest traffic volume. Subscriber bandwidth and volume reports are available for 
those subscribers configured for real-time monitoring. In Cisco Service Control Application for 
Broadband User Guide, see Selecting Subscribers for Real-Time Usage Monitoring, for a 
description of how to configure real-time subscribers. 

Table C-14 Common Parameters for Subscriber Monitoring Group 

Parameter Field Type Default Mandatory Remembered Comments 

Subscriber 
name 

Free Text not set √  IP address (decimal format) 
or subscriber name. This 
parameter is common to all 
the report templates, except 
"Top Subscribers". 

Services to 
View 

Multiple 
Choice 

not set   List of service counters 
available for this subscriber 
domain. All services, when 
not set. This parameter is 
common to all the report 
templates, except "Top 
Subscribers". 

 

 
 

Top Subscribers 
For a given time frame, Top Subscribers shows a list of the top subscriber volume consumption in 
a specific hour/day. 

Table C-15 Top Subscribers Template 

Parameter Field 
Type 

Default Mandatory Remembered Comments 

Specific Time Date/Time not set √  Select specific time. Note 
that the selected time is 
rounded to the nearest 
hour/day. 

Limit number 
of results 

Free Text 10 √  Type a number. 

Filter to 
Metric 

Single 
Choice 

Both 
Directions 
Volume 

√  Select one of the directions 
of the volume, aggregate 
sessions or aggregate 
duration. 

Aggregation 
Period 

Single 
Choice 

Hourly √  Select one aggregation 
period: Hourly or Daily. 
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Parameter Field 
Type 

Default Mandatory Remembered Comments 

Focus on the 
service 

Single 
Choice 

not set   Select service. When this 
parameter is not set, the 
default is all services. 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 

Show other 
Consumption 

Boolean False √  Select True or False. 

Subscriber Id Free Text not set   Pattern which represent 
group of subscribers. 

 

 
 

Subscriber Bandwidth per Service 
For a given time frame, Subscriber Bandwidth per Service shows the distribution of bandwidth 
among the different service counters defined in the system for a particular subscriber. 

Table C-16 Subscriber Bandwidth per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

Average 
data by hour 

Boolean False √  Select option or not. 

 

 
 

Subscriber Aggregated Usage Volume per Service 
For a given time frame, Subscriber Aggregated Usage Volume per Service shows the most popular 
Service counter for a particular subscriber. 

Table C-17 Subscriber Aggregated Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 
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Subscriber Hourly Usage Volume per Service 
For a given time frame, Subscriber Hourly Usage Volume per Service shows the hourly 
distribution of volume between the different service counters defined in the system for a particular 
subscriber. 

Table C-18 Subscriber Hourly Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

 

 
 

Subscriber Hourly Aggregated Minutes per Service 
For a given time frame, Subscriber Hourly Aggregated Minutes per Service shows the total 
number of minutes spent for service counters for a specific package counter defined in the system, 
grouped by hour. 

See Subscriber Monitoring (on page C-15) for a table of common parameters for the Subscriber 
Monitoring group. 
 

Subscriber Hourly Usage Session per Service 
For a given time frame, Subscriber Hourly Usage Sessions per Service shows the hourly 
distribution of sessions between the different service counters defined in the system for a 
particular subscriber. 

See Subscriber Monitoring (on page C-15) for a table of common parameters for the Subscriber 
Monitoring group. 
 

Subscriber Daily Usage Session per Service 
For a given time frame, Subscriber Daily Usage Sessions per Service shows the daily distribution 
of sessions between the different service counters defined in the system for a particular subscriber. 

See Subscriber Monitoring (on page C-15) for a table of common parameters for the Subscriber 
Monitoring group. 
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Subscriber Daily Usage Volume per Service 
For a given time frame, Subscriber Daily Usage Volume per Service shows the daily distribution 
of volume between the different service counters defined in the system for a particular subscriber. 

Table C-19 Subscriber Daily Usage Volume per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth: 
Upstream, Downstream, or 
Both Directions. 

 

 
 

Traffic Discovery - Statistics 
Use the Traffic Discovery - Statistics group of reports to view statistics compiled from the source 
and destination IP addresses and ports of the system traffic. 

 

 
 

Note The reports in this group are not per subscriber; they supply general Port and IP address information. 
 

Table C-20 Common Parameters for Traffic-Discovery Statistics Group 

Parameter Field 
Type 

Default Mandatory Remembered Comments 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 

Subscriber 
name 

Free Text not set   IP address (decimal 
format) or subscriber 
name. 

Limit 
Number of 
Results 

Free Text 10 √  Type of number. 

Time 
Frames to 
focus 

Multiple 
Choice 

not set   Select one or more of four 
time frame options. 

Traffic 
Direction 

Single 
Choice 

Downstream 
Volume 

√  Select one traffic direction. 

Packages to 
View 

Multiple 
Choice 

not set   List packages available for 
this subscriber domain. 

Services to 
View 

Multiple 
Choice 

not set   List of services available 
for this subscriber domain. 
All services, when not set. 
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Top Servers 
For a given time frame, Top Servers shows the most popular servers for certain services.  

 

 
 

Note The "Server" refers to the IP address of the other side of the flow initiator and may be located on the 
Subscriber side or on the Network side. 

 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
 

Top Clients 
For a given time frame, Top Client shows the most popular client IP for certain services. 

 

 
 

Note The "Client" refers to the IP address of the flow initiator and may be located on the Subscriber side or 
on the Network side. 

 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
 

Top Server Ports 
For a given time frame, Top Server Ports shows the most popular server ports for certain services. 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
 

Top Service Ports 
For a given time frame, Top Service Ports shows the most popular server ports of a certain service 
or services. 

Table C-21 Top Service Ports Template 

Parameter Field Type Default Mandatory Remembered Comments 

Transport 
Protocol 

Single 
Choice 

TCP √  Choose a transport protocol: 
TCP or UDP. 
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Top Protocols 
For a given time frame, Top Protocols show the most popular protocol for certain services. 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
 

Top IP Protocols 
For a given time frame, Top IP Protocols show the most popular IP protocol for certain services. 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
 

Top Server IP to Server Port 
For a given time frame, Top Server IP to Server Port shows the most popular server IP to server 
port for certain services. 

Table C-22 Top Server IP to Server TCP Port Template 

Parameter Field Type Default Mandatory Remembered Comments 

Transport 
Protocol 

Single 
Choice 

TCP √  Choose a transport protocol: 
TCP or UDP. 

 

 
 

Top Client IP To Server Port 
For a given time frame, Top Client IP To Server Port shows the most popular client IP to server 
port for certain services. 

Table C-23 Top Client IP to Server Port Template 

Parameter Field Type Default Mandatory Remembered Comments 

Transport 
Protocol 

Single 
Choice 

TCP √  Choose a transport protocol: 
TCP or UDP. 

 

 
 

Top Client IP to Server IP 
For a given time frame, Top Client IP to Server IP shows the most popular client IP to server IP 
for certain services. 

See Traffic Discovery - Statistics (on page C-18) for a table of common parameters for the Traffic 
Discovery - Statistics group. 
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Top Client IP to Server IP and Server Port 
For a given time frame, Top Client IP to Server IP and Server Port shows the most popular server 
IP and server port for certain services. 

Table C-24 Top Client IP To Server IP and Server TCP Port Template 

Parameter Field Type Default Mandatory Remembered Comments 

Transport 
Protocol 

Single 
Choice 

TCP √  Choose a transport protocol: 
TCP or UDP. 

 

 
 

Demographic Data and Service Popularity Reports 
Use Demographic group of reports to view statistics of the demographic data. 

Table C-25 Common Parameters for Demographic Data and Service Popularity Group 

Parameter Field Type Default Mandatory Remembered Comments 

Link to 
Focus 

Multiple 
Choice 

not set   List of available links to 
focus. 

Select 
Service to 
View 

Single 
Choice 

not set √  List of service counters 
available for this subscriber 
domain. 

 

 
 

Global Active Subscriber per Service 
For a given time frame, Global active subscriber per Service shows the distribution of subscribers 
among the different services defined in the system for all traffic, regardless of subscriber or 
package. 

See Demographic Data and Service Popularity Reports (on page C-21) for a table of common 
parameters for the Demographic Data and Service Popularity group. 
 

Package Active Subscriber per Service 
For a given time frame, Package Active subscriber per Service shows the distribution of 
bandwidth between the different services defined in the system for specific subscriber package. 

Table C-26 Package Active Subscriber per Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Package Single 
Choice 

not set √  Default Package or 
Unknown Package 
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Service Popularity among Subscribers 
For a given time frame, Service Popularity among subscribers shows the percentage of  
subscribers using a specific service defined in the system. 

See Demographic Data and Service Popularity Reports (on page C-21) for a table of common 
parameters for the Demographic Data and Service Popularity group. 
 

Service Popularity among Subscribers of Specific Package 
For a given time frame, Service popularity among subscribers of a specific package shows the 
percentage of subscribers using a specific service in a specific package defined in the system. 

Table C-27 Service Popularity among Subscribers of Specific Package Template  

Parameter Field Type Default Mandatory Remembered Comments 

Package Single 
Choice 

not set √  Select one of the package 
counters. 

 

 
 

Relative Consumption of Top Subscribers 
For a given time frame, Relative consumption of top subscribers shows the relative consumption 
of a specific number of subscribers compared to "other". 

Table C-28 Relative Consumption of Top Subscribers Template 

Parameter Field 
Type 

Default Mandatory Remembered Comments 

Specific Time Date/Time not set √  Select specific time. Note 
that the selected time is 
rounded to the nearest 
hour/day. 

Limit number 
of results 

Free Text 10 √  Type a number. 

Filter to 
Metric 

Single 
Choice 

Both 
Directions 
Volume 

√  Select one of the directions 
of the volume, aggregate 
sessions or aggregate 
duration. 

Aggregation 
Period 

Single 
Choice 

Hourly √  Select one aggregation 
period: Hourly or Daily. 

Focus on the 
service 

Single 
Choice 

not set   Select service. 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 
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Parameter Field 
Type 

Default Mandatory Remembered Comments 

Show other 
Consumption 

Boolean False √  Select True or False. 

Subscriber Id Free Text not set   Pattern which represent 
group of subscribers. 

 
 

 
 

Service Popularity among Subscribers (Average) 
For a given time frame, Service popularity among Subscribers (Average) shows the total number 
of subscribers using a specific service compared to subscribers using all other services. 

See Demographic Data and Service Popularity Reports (on page C-21) for a table of common 
parameters for the Demographic Data and Service Popularity group. 
 

Service Popularity among Subscribers of Specific Package (Average) 
For a given time frame, Service popularity among Subscribers of a specific package (Average) 
shows the total number of subscribers using a specific service compared to subscribers using all 
other services in a specific package. 

Table C-29 Service Popularity among Subscribers of Specific Package (Average) 
Template  

Parameter Field Type Default Mandatory Remembered Comments 

Package Single 
Choice 

not set √  Select one of the package 
counters.  

 

 
 

Web and Streaming Reports 
Use the Web and Streaming group of reports to compile statistics presenting the most popular 
servers or hosts for the various pre-defined system services (such as Browsing, Streaming, and 
Downloading) and for user-defined services. 

Table C-30 Common Parameters for Web and Streaming Group 

Parameter Field Type Default Mandatory Remembered Comments 

Units of 
Results 

Single 
Choice 

Hits √  Select results units: Mbytes, 
KBytes, or Hits. 

Subscriber 
name 

Free Text not set   IP address (decimal format) 
or subscriber name. 
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Parameter Field Type Default Mandatory Remembered Comments 

Limit 
Number of 
Results 

Free Text 10 √  Type of number. 

Time 
Frames to 
focus 

Multiple 
Choice 

not set   Select one or more of four 
time frame options. 

Metric to 
order/ 
Traffic 
Direction 

Single 
Choice 

Both 
Directions 
Volume 

√  Select one of the directions 
of the volume or Hit Count. 

Packages to 
View 

Multiple 
Choice 

not set   List packages available for 
this subscriber domain. 

Services to 
View 

Multiple 
Choice 

not set   List of services available for 
this subscriber domain. All 
services, when not set. 

 

 
 

Top Web Hosts 
For a given time frame, Top Web Hosts shows the most popular web servers. 

Table C-31 Top Web Hosts Template 

Parameter Field Type Default Mandatory Remembered Comments 

Show other 
consumption 

Boolean False √  Select when to include the 
other consumption in the 
report. 

Where host 
contains 

Free Text not set   Filter to hosts containing the 
given pattern. 

 

 
 

Top Rtsp Hosts 
For a given time frame, Top Rtsp Hosts shows the most popular real-time streaming protocol 
(Rtsp) servers. 

Table C-32 Top Rtsp Hosts Template 

Parameter Field Type Default Mandatory Remembered Comments 

Show other 
consumption 

Boolean False √  Select when to include the 
other consumption in the 
report. 
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Parameter Field Type Default Mandatory Remembered Comments 

Where host 
contains 

Free Text not set   Filter to hosts containing the 
given pattern. 

 
 

Top FTP Servers 
For a given time frame, Top FTP Servers shows the most popular FTP file hosts. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Top MMS Servers 
For a given time frame, Top MMS Servers shows the most popular MMS hosts. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Top Service Servers 
For a given time frame, Top Service Servers shows the most popular servers of a certain service 
or services. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Web Hosts Distribution by Subscriber Packages 
For a given time frame, Service Distribution by Subscriber Packages shows the most popular web 
servers, grouped by the package of the requesting subscriber. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Rtsp Host Distribution by Subscriber Packages 
For a given time frame, Rtsp Host Distribution by Subscriber Packages shows the most popular 
real-time streaming protocol servers, grouped by the package of the requesting subscriber. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

FTP Server Distribution by Subscriber Packages 
For a given time frame, FTP Server Distribution by Subscriber Packages shows the most popular 
FTP file servers, grouped by the package of the requesting subscriber. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
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MMS Server Distribution by Subscriber Packages 
For a given time frame, MMS Server Distribution by Subscriber Packages shows the most 
popular Microsoft Manager Server servers, grouped by the package of the requesting subscriber. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Service Distribution by Subscriber Packages 
For a given time frame, Service Distribution by Subscriber Packages shows the distribution of 
service usage according to the subscriber packages. 

See Web and Streaming Reports (on page C-23) for a table of common parameters for the Web 
and Streaming group. 
 

Mail and News Reports 
Use the Mail and News group of reports to view statistics of the mail and news traffic. 

Table C-33 Common Parameters for Mail and News Group 

Parameter Field Type Default Mandatory Remembered Comments 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 

Subscriber 
name 

Free Text not set   IP address (decimal format) 
or subscriber name. 

Limit 
Number of 
Results 

Free Text 10 √  Type of number. 

Time 
Frames to 
focus 

Multiple 
Choice 

not set   Select one or more of four 
time frame options. 

Metric to 
order/ 
Traffic 
Direction 

Single 
Choice 

Upstream 
Volume 

√  Select one traffic 
direction/metrics. 

Packages to 
View 

Multiple 
Choice 

not set   List packages available for 
this subscriber domain. 

Services to 
View 

Multiple 
Choice 

not set   List of services available for 
this subscriber domain. All 
services, when not set. 
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Top SMTP Servers 
For a given time frame, Top SMTP Servers shows the most popular SMTP hosts. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top POP3 Servers 
For a given time frame, Top POP3 Servers shows the most popular POP3 hosts. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top NNTP Servers 
For a given time frame, Top NNTP Servers shows the most popular NNTP hosts. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top E-mail Sender 
For a given time frame, Top E-mail Sender shows the top e-mail sender. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top E-mail Recipients 
For a given time frame, Top E-mail Recipients shows the top e-mail recipients. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top NNTP Consumers 
For a given time frame, Top NNTP Consumers shows the top NNTP Consumers. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top Newsgroups 
For a given time frame, Top Newsgroups shows the most popular newsgroups. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
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SMTP Server Distribution by Subscriber Packages 
For a given time frame, SMTP Server Distribution by Subscriber Packages shows the most 
popular SMTP servers, grouped by the package of the requesting subscriber. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

POP3 Server Distribution by Subscriber Packages 
For a given time frame, POP3 Server Distribution by Subscriber Packages shows the most 
popular POP3 servers, grouped by the package of the requesting subscriber. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

NNTP Server Distribution by Subscriber Packages 
For a given time frame, NNTP Server Distribution by Subscriber Packages shows the most 
popular NNTP servers, grouped by the package of the requesting subscriber. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top Subscriber to Newsgroup 
For a given time frame, Top Subscriber to Newsgroup shows the top subscriber to newsgroup for 
certain services. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News group. 
 

Top E-mail Account Owners 
For a given time frame, Top E-mail Account Owners shows the top e-mail account owners. 

See Mail and News Reports (on page C-26) for a table of common parameters for the Mail and 
News  group. 
 

P2P Reports 
Use the P2P Reports group of reports to view statistics of the P2P traffic. 

Table C-34 Common Parameters for P2P Group 

Parameter Field Type Default Mandatory Remembered Comments 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 

Subscriber 
name 

Free Text not set   IP address (decimal format) 
or subscriber name. 
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Parameter Field Type Default Mandatory Remembered Comments 

Limit 
Number of 
Results 

Free Text 10 √  Type of number. 

Time 
Frames to 
focus 

Multiple 
Choice 

not set   Select one or more of four 
time frame options. 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 
Volume 

√  Select one traffic 
direction/metrics. 

Packages to 
View 

Multiple 
Choice 

not set   List packages available for 
this subscriber domain. 

Services to 
View 

Multiple 
Choice 

not set   List of services available for 
this subscriber domain. All 
services, when not set. 

 

 
 

Top P2P Protocols 
For a given time frame, Top P2P Protocols shows the most popular P2P protocol for certain 
services. 

See P2P Reports (on page C-28) for a table of common parameters for the P2P group. 
 

Top P2P Consumers 
For a given time frame, Top P2P Consumers shows a list of the top P2P subscriber volume 
consumption. 

See P2P Reports (on page C-28) for a table of common parameters for the P2P group. 
 

Top P2P Downloaders 
 For a given time frame, Top P2P Downloaders shows the top P2P downloader consumers. 

See P2P Reports (on page C-28) for a table of common parameters for the P2P group. 
 

Top P2P Uploaders 
 For a given time frame, Top P2P Uploaders shows the most popular P2P uploader consumers. 

See P2P Reports (on page C-28) for a table of common parameters for the P2P group. 
 

Top P2P Protocols 
For a given time frame, Top P2P File Extensions shows the most popular P2P file-extensions 

See P2P Reports (on page C-28) for a table of common parameters for the P2P group. 
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VoIP Reports 
Use the VoIP group of reports to view statistics of the VoIP traffic. 

Table C-35 Common Parameters for VoIP Group 

Parameter Field Type Default Mandatory Remembered Comments 

Link to 
Focus 

Single 
Choice 

not set   List of available links to 
focus. 

Services to 
View 

Multiple 
Choice 

not set   List of VoIP services  
available for this subscriber 
domain. When this 
condition is not set, the 
default is all the services are 
chosen. 

 

 
 

Global Bandwidth per VoIP Service 
For a given time frame, Global Bandwidth per VoIP Service shows the distribution of bandwidth 
among the different VoIP services defined in the system for all traffic, regardless of subscriber or 
package. 

Table C-36 Global Bandwidth per VoIP Service Template  

Parameter Field Type Default Mandatory Remembered Comments 

Average 
Data by 
Hour 

Boolean True √   

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth.  

 

 
 

Global Concurrent Calls per VoIP Service 
For a given time frame, Global Concurrent Calls per VoIP Service shows the distribution of 
concurrent sessions between the different VoIP service counters defined in the system, grouped by 
day. 

See VoIP Reports (on page C-30) for a table of common parameters for the VoIP group. 
 

Global Hourly Call Minutes per VoIP Service 
For a given time frame, Global Hourly Call Minutes per VoIP Service shows the distribution of 
Call Minutes between the different VoIP service counters defined in the system, grouped by day. 

See VoIP Reports (on page C-30) for a table of common parameters for the VoIP group. 
 



   

Command-Line Interface 
 

 

Cisco Service Control Application Reporter User Guide   

OL-8411-01  I-C-31 
 

 

Package Bandwidth per VoIP Service 
For a given time frame, Package Bandwidth per VoIP Service shows the distribution of bandwidth 
between the different VoIP services defined in the system for the traffic of subscribers in a specific 
package. 

Table C-37 Package Bandwidth per VoIP Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Package Single 
Choice 

not set √  Select one of the package 
counters. 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth. 

 

 
 

Package Concurrent Calls per VoIP Service 
For a given time frame, Packet Concurrent Calls per VoIP Service shows the distribution of 
concurrent sessions between the different VoIP service counters defined in the system, grouped by 
day. 

See VoIP Reports (on page C-30) for a table of common parameters for the VoIP group. 
 

Package Hourly Call Minutes per VoIP Service 
For a given time frame, Global Hourly Call Minutes per VoIP Service shows the distribution of 
Call Minutes between the different VoIP service counters defined in the system, grouped by day. 

Table C-38 Package Hourly Call Minutes per VoIP Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Package Single 
Choice 

not set √  Select one of the package 
counters: Default Package 
or Unknown Subscriber 
Traffic 
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Subscriber Bandwidth per VoIP Service 
For a given time frame, Subscriber Bandwidth per VoIP Service shows the distribution of 
bandwidth between the different VoIP services defined in the system for the traffic of subscriber 
in a specific package. 

Table C-39 Subscriber Bandwidth per VoIP Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Subscriber 
Name 

Free Text not set √  IP address (decimal format) 
or subscriber name. 

Traffic 
Direction 

Single 
Choice 

Both 
Directions 

√  Select one of the directions 
of the bandwidth. 

 

 
 

Subscriber Hourly Call Minutes per VoIP Service 
For a given time frame, Subscriber Hourly Call Minutes per VoIP Service shows the distribution 
of Call Minutes between the different VoIP service counters defined in the system, grouped by 
day. 

Table C-40 Subscriber Hourly Call Minutes per VoIP Service Template 

Parameter Field Type Default Mandatory Remembered Comments 

Subscriber 
Name 

Free Text not set √  IP address (decimal format) 
or subscriber name.  

 

 
 

Top SIP Domains 
For a given time frame, Top SIP Domains shows the most popular SIP Domains. 

Table C-41 Top SIP Domains Template 

Parameter Field Type Default Mandatory Remembered Comments 

Units of 
Results 

Single 
Choice 

Hits √  Select results units: Mbytes,  
KBytes, or Hits. 

Subscriber 
Name 

Free Text not set   IP address (decimal format) 
or subscriber name. 

Limit 
Number of 
Results 

Number 10 √  Type of Number. 

Time 
Frames to 
focus 

Multiple 
Choice 

not set   Select one or more of four 
time frame options. 
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Parameter Field Type Default Mandatory Remembered Comments 

Metric To 
Order/ 
Traffic 
Direction 

Single 
Choice 

Hit_Count √  Select one traffic direction/ 
Metrics. 

Packages to 
View 

Multiple 
Choice 

not set   List of packages available 
for this subscriber domain. 

 

 
 

Top Talkers 
For a given time frame, Top Talkers shows a list of the top talker volume/session/minutes 
consumption in a specific hour/day for a specific/all VoIP services. 

Table C-42 Top Talkers Template 

Parameter Field 
Type 

Default Mandatory Remembered Comments 

Specific Time Date/Time not set √  Select specific time. Note 
that the selected time is 
rounded to the nearest 
hour/day. 

Limit number 
of results 

Free Text 10 √  Type a number. 

Filter to 
Metric 

Single 
Choice 

Hit_count √  Select one of the directions 
of the volume, aggregate 
sessions or aggregate 
duration. 

Aggregation 
Period 

Single 
Choice 

Hourly √  Select one aggregation 
period: Hourly or Daily. 

Focus on the 
VoIP service 

Single 
Choice 

not set   Select service. 

Units of 
Results 

Single 
Choice 

MBytes √  Select results units: Mbytes 
or KBytes. 

Show other 
Consumption 

Boolean False √  Select True or False. 

Subscriber Id Free Text not set   Pattern which represent 
group of subscribers. 
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Malicious Traffic 
Use the Malicious Traffic group of reports to view statistics of the malicious events accrued in the 
system. 

Table C-43 Common Parameters for Malicious Traffic Group 

Parameter Field Type Default Mandatory Remembered Comments 

IP protocol Single 
Choice 

not set   List of available IP protocol 
to focus. 

Filter to port Free Text not set   Filter to attack port. 
(available in all report 
groups except top scanning 
attacking subscribers and 
top scanned or attacked 
subscribers) 

 

 
 

Global Scan or Attack Rate 
For a given time frame, Global Scan or Attack Rate shows the rate (session/sec) of scan/attacks 
originating from the hosts (typically due to worm or zombie). 

Table C-44 Global Scan or Attack Rate Template 

Parameter Field Type Default Mandatory Remembered Comments 

Detected IP 
side 

Single 
Choice 

not set   Select between Subscriber 
and Network side. 

 

 
 

Global DoS Rate 
For a given time frame, Global DoS Rate shows the rate (sessions/sec) of DoS attacks on the 
targeted host. 

Table C-45 Global DoS Rate Template  

Parameter Field Type Default Mandatory Remembered Comments 

Detected IP 
side 

Single 
Choice 

not set   Select between Subscriber 
and Network side. 
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Top Scanning or Attacking Hosts 
For a given time frame, Top Scanning or Attacking hosts shows the top hosts identified as DoS 
attacking. 

Table C-46 Top Scanning or Attacking Hosts Template  

Parameter Field Type Default Mandatory Remembered Comments 

Attack 
Metric 

Single 
Choice 

Attacks √  Select one of the available 
metrics (attacks, malicious 
sessions, or duration(min)). 

Detected IP 
side 

Single 
Choice 

not set   Select between Subscriber 
or Network side. 

 

 
 

Top DoS Attacked Hosts 
For a given time frame, Top DoS Attacked Hosts shows the top DoS attacked hosts. 

Table C-47 Top DoS Attacked Hosts Template  

Parameter Field Type Default Mandatory Remembered Comments 

Attack 
Metric 

Single 
Choice 

Attacks √  Select one of the available 
metrics (attacks, malicious 
sessions, or duration(min)). 

Detected IP 
side 

Single 
Choice 

not set   Select between Subscriber 
or Network side. 

 

 
 

Infected Subscribers 
For a given time frame, Infected Subscribers shows the distribution infected Subscribers over time 
among the different IP protocol in the system. 

See Malicious Traffic (on page C-34) for a table of common parameters for the Malicious Traffic 
group. 
 

DoS Attacked Subscribers 
For a given time frame, DoS Attacked Subscribers shows the distribution of DoS Attacked 
Subscribers over time among the different IP protocol defined in the system. 

See Malicious Traffic (on page C-34) for a table of common parameters for the Malicious Traffic 
group. 
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Top DoS Attacked Subscribers 
For a given time frame, Top DoS Attacked Subscribers shows the top DoS attacked subscribers.. 

See Malicious Traffic (on page C-34) for a table of common parameters for the Malicious Traffic 
group. 
 

Top Scanning or Attacking Subscribers 
For a given time frame, Top Scanning or Attacking subscribers shows the top subscribers 
identified as DoS attacking. 

Table C-48 Top Scanning or Attacking Subscribers Template  

Parameter Field Type Default Mandatory Remembered Comments 

Attack 
Metric 

Single 
Choice 

Attacks √  Select one of the available 
metrics (attacks, malicious 
sessions, or duration(min)). 

 

 
 

Top Scanned or Attacked Ports 
For a given time frame, Top Scanned or Attacked Ports shows the top scanned attacked ports. 

Table C-49 Top Scanned or Attacked Ports Template  

Parameter Field Type Default Mandatory Remembered Comments 

Attack 
Metric 

Single 
Choice 

Attacks √  Select one of the available 
metrics (attacks, malicious 
sessions, or duration(min)). 
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